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Preface
Quick Surface Reconstruction easily and quickly recovers surfaces from digitized data that has been cleaned up 
and tessellated using the Digitized Shape Editor product. 

Quick Surface Reconstruction offers several approaches to recover surfaces depending of the type of shape : 

●     Organic shapes, i.e. free form surfaces, without features such as cylinders, fillets, planes, etc.

●     Mechanical shapes (plane, cylinder, sphere, cone).

Thanks to Quick Surface Reconstruction tools that analyze curvature or iso-slope properties, users can easily 
create polygon segmentations in pertinent surfaces area. Quick Surface Reconstruction includes its own quality 
checking tools.

The Quick Surface Reconstruction  user's guide has been designed to show you how to reconstruct surfaces 
using these powerful tools. We recommend that you go through the "Getting Started" chapters first, to learn 
more about those working methods.

 

Using this Guide
More Information

Conventions
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Using this Guide
This User's Guide is intended for the user who needs to become quickly efficient with Quick Surface 
Reconstruction. Before reading it, you should be familiar with the basic concepts, such as the document 
windows, standard toolbars and menus.

To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter first of 
all and the Workbench Description to find his way around the Quick Surface Reconstruction  workbench. 
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Where to Find More Information 
Prior to reading this book, we recommend that you read the Infrastructure User's Guide that describes generic 
capabilities common to all products. It also describes the general layout and interoperability between 
workbenches.
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and understand 
important concepts and specifications. The following text conventions may be used:
  The titles of CATIA documents appear in this manner throughout the text.
  File -> New identifies the commands to be used.

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button, whenever you read

Select (menus, commands, geometry in graphics area, ...)
Click (icons, dialog box buttons, tabs, selection of a location in the document window, ...)
Double-click
Shift-click
Ctrl-click
Check (check boxes)
Drag
Drag and drop (icons onto objects, objects onto objects)

Drag
Move

Right-click (to select contextual menu)

Graphic conventions are denoted as follows:

indicates the estimated time to accomplish a task.

indicates a target of a task.

indicates the prerequisites.

indicates the scenario of a task.

indicates tips

indicates a warning.

indicates information.

indicates basic concepts.
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indicates methodological information.

indicates reference information.

indicates information regarding settings, customization, etc.

indicates the end of a task.

indicates functionalities that are new or enhanced with this Release.
Enhancements can also be identified by a blue-colored background in the left-hand margin or on 
the text itself.

indicates functionalities that are P1-specific.

indicates functionalities that are P2-specific.

indicates functionalities that are P3-specific.

allows you to switch back the full-window viewing mode.

 

These icons in the table of contents correspond to the entries or mode.

"Site Map".

"Split View" mode.

"What's New".

"Preface".

"Getting Started".

"Basic Tasks".

"User Tasks" or the "Advanced Tasks".

"Workbench Description".

"Customizing".

"Reference".

"Methodology".
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"Glossary".

"Index".
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What's New?

Enhanced Functionalities

Curve from Scans
In the Smoothing mode, curves are now created with a maximum order value (instead of a minimum order value in 
previous releases). The number of segments remains the maximum possible one. Split points can now be moved 
dynamically along the scan, and the Remove all points option has been added to the contextual menu of Split points. 

Curves Network
Overlapping input curves are detected. A contextual menu is available to remove selected curves in the dialog box. The 
node tolerance value is visualized as a sphere. A tab page has been added to freeze some input curves.

Distance Analysis
A texture mapping option has been added.

Cloud Display
The Vertex display option has been added for a lighter display of meshes.
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Getting Started
The following tutorial aims at giving you a feel of what you can do with Quick Surface Reconstruction. It 
provides a step-by-step scenario showing you how to use key capabilities.

Quick Surface Reconstruction offers several approaches:

●     N-side domain approach with boundary constraints and deviation tolerance through inner points: 

●     reconstructs surfaces that do not require the conservation of fillets or mechanical features,

●     is a good compromise between quality and productivity,

●     the result can be adjusted by deformation of the domain.

●     Untrimmed approach: 

●     reconstructs surfaces including the fillets,

●     does not require the creation of curves,

●     enables the recovery of virtual sharp edges,

●     applies fillets on virtual edges (adjustable radius).

●     Mechanical approach: 

●     reconstructs surfaces with fillets and mechanical features

●     models virtual sharp edges,

●     identifies mechanical features,

●     reconstructs fillets on virtual edges

●     enables to modify fillets and mechanical features through their parameters.

Whatever the method you choose, we recommend to work with polygons rather than with clouds of points.

 

The "Getting Started" part of this guide will illustrate the first approach, with the following tasks:

Starting the Quick Surface Reconstruction Workbench
Preparing the Part

Reconstruction of Surfaces

Note that we have changed the color of curves to blue and eventually renamed elements in the specification 
tree.
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All together this scenario should take 15 minutes  to complete. 

The final cloud element will look like this:
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Starting the Quick Surface Reconstruction Workbench

The first task will show you how to enter the Quick Surface Reconstruction  workbench and open data.

The only pre-requisites for this task is to have a current session running.

1.  Choose Quick Surface Reconstruction from the Start menu.

The Quick Surface Reconstruction  workbench is displayed and ready to use.
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2.  Click the Open icon  or select the File->Open... command. The following dialog box appears: 

3.  In the File Selection box, select the file location. Open the GettingStarted01.CATPart from the samples directory.

For more information, see Creating, Opening and Saving Documents  in the Infrastructure User's Guide.

If you wish to use the whole screen space for the geometry, uncheck  Specification in the View menu.
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Preparing the part
This task prepares the part for the reconstruction: 

●     creation of a curve defining a symmetry plane,

●     creation of a surface tangent to the polygon,

●     definition of reconstruction zones. 

Open the GettingStarted01.CATPart from the samples directory.

Create the curve defining the symmetry plane: 

1.  Click the Planar Sections icon  and the select the polygon.

2.  Select the xy plane, enter 1 for the number of sections. Move the plane slightly upwards until a complete scan 

is visible. Clik Apply, the scan is computed, PlanarSections.1 is displayed in the specification tree. 

 

3.  Check the curve creation option. The Curve from Scans dialog box is displayed. A curve is computed. Its 

segmentation is displayed, and Curve.1 is displayed in the specification tree.  
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4.  Set the parameters in the Curve from Scans dialog box to your needs and pick the requested points on the 

computed curve to split it into several smaller curves. The first segmentation proposed is erased and the 

splitting points are displayed. 
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5.  Click Apply in the Curve from Scans dialog box: the curves are computed. Their segmentation is displayed as 

well as the gaps between the curves and the polygon. If necessary, pick on a green square to remove this split 

point, and pick another point of the scan to create a new split point. Click Apply to take those modifications 

into account. 
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6.  If necessary, check the Curvature analysis option to check the quality of the curves created.
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7.  Once you are satisfied, click OK to validate the curves. The Curve.1 to Curve.10 elements are created in the 

specification tree. 

8.  If you wish, you can change the color of those curves using the Edit/Properties menu.
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Create a tangent surface around the polygon:

1.  Click the Join icon  and select the curves on the screen. Change the merging distance to 0.01mm. Click 

OK.  The Join.1 element is created in the specification tree.

2.  Click the Translate icon  and select Join.1 Enter the xy plane for Direction and -15 mm for Distance. 
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3.  Click Preview and OK. The Translate.1 element is created in the specification tree.

4.  Click the Loft Surface icon . Select Join.1 and Translate.1. Click Preview and OK. 
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Loft.1 is created in the specification tree.
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 Define reconstruction zones on the polygon: 

1.  Use the Plane action from the WireFrame toolbar to create planes through 3 points using split points of step 1 

and their counterpart on Translate.1:

 

2.  Click the Planar Sections icon . Select the polygon. 

3.  Click the Plane icon in the dialog box and select one of the plane you have created. Enter 1 in the Number 

field. Create a curve as above. Repeat this step for each plane. Curve.11 to Curve.16 are created in the 

specification tree.

4.  Click the 3D Curve icon  and create curves as follows:

3D Curve.16 to 3D Curve.21 are created in the specification tree.
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Reconstruction of Surfaces

The first task will show you how to create a clean contour

To make selection easier, hide the following elements: 
●     the polygon

●     the curves created to build the tangent surface.

Create a clean contour: 

1.  Click the Clean Contour icon  and select the following curves or edges: 

You see that the clean contour action takes the existing constraints into account: the edges of the surface are fixed. 

Click Apply and OK. A Join.2 element is created in the specification tree. The input curves have been sent to the 

NoShow.

You see that curves have been trimmed.
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2.  Recall the polygon from the NoShow.

Reconstruct a surface: 

1.  Click the PowerFit icon . Select the polygon. It is sent to the NoShow. Select Join.2. 

You can see that existing constraints are again taken into account.

2.  In the Parameters frame, check the Radius option and enter 10 as a radius value. 

3.  Click Apply and OK. A Surface.1 element is created in the specification tree.

25Page Quick Surface Reconstruction Version 5 Release 13



Reconstruct a second surface: 

1.  If necessary, recall hidden curves from the NoShow and create a clean contour as above. A Join.3 element is created in the 

specification tree. 

 

2.  Recall the polygon from the NoShow.

3.  Create a second PowerFit surface as above using the recently created clean contour.

You can reconstruct the other surfaces the same way.
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User Tasks
Cloud Edition

Scan and Curve Creation
Clean Contour Creation

Surface Creation
Transformations
Segmentation

Analysis
WireFrame

Interoperability
Display Options

Managing Geometrical Sets
Operations
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Cloud Edition
This chapter deals with the Activation of portions of clouds of points or polygons.
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Activating a Portion of a Cloud of Points
This task shows how to select a portion of a cloud of points or of mesh in order to create a work area, 
either: 

●     by picking directly elements of the cloud (points, scans, grids, cells, clouds) or

●     by defining a portion of the cloud or mesh with a 2D or 3D trap.

Open the Cloud.CATPart model the from the samples directory.

1.  Click the Activate icon  and the cloud of points or mesh. The Activate Points dialog box is 

displayed. 

 

The Apply button has been replaced by the Valid Trap button and the OK button:

●     To activate an area by picking elements, select them and click OK to confirm the 
activation and close the dialog box.

●     To create a single activation area by trap, draw the trap, modify it when necessary 
and  click OK to confirm the activation and close the dialog box.

●     To create several activation areas by traps, draw the first trap, modify it when 
necessary, click Valid Trap to validate this trap. Repeat these steps for each trap 
then click OK to confirm the activation and close the dialog box.
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You can define : 
●     the Selection Type: 

Pick: activation occurs by direct picking, according to the level of selection:

Point

Scan or Grid

Cell (sub-
element of a 
cloud)
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Cloud (global 
cloud)

 

●     Trap: the points are selected using a graphic trap:

●     either Rectangular or

●     Polygonal or
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●     Spline.

 

As long as you have not double-clicked to end the polygonal trap, you can undo/redo each pick of the 
polygonal trap.

●     The activated points are those that appear in red during the selection.

●     By default, as shown above, the trap is displayed in the view plane. It is thus a 2D trap.

●     You can rotate the model to display it as a 3D trap.

●     You can modify the shape of the trap using the green arrows that appear on the edges of the trap.
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●     You can create as many areas as you wish by clicking Valid Trap and drawing another trap, until 
you click OK to validate and exit the action.

●     If you draw a trap and click Valid Trap, and then choose Swap, you validate the complement of the 
trap.

2.  You can choose to keep the points :

●     Inside the trap or

●     Outside the trap.
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You can select an activated portion of a cloud of points or a mesh and recall the activation action to: 

●     Activate all (the whole cloud of points or mesh is re-activated),

●     Swap  the selection (the complement of the current selection becomes active whereas the current 

selection is hidden)

●     The Activation action displays only triangles that are fully selected (i.e. the whole triangle is inside 
the selection trap, or all its vertices have been picked). If you select only one or two vertices of a 
triangle, or if the selection trap intersects the triangle, it is not displayed.

●     As a consequence, when you push the button Swap, the triangles displayed are not the exact 
complement of the previous selection.

The free edges displayed are those of the complete mesh: 
●     if you activate only a portion of a mesh, the free edges of that portion are not displayed.

 

34Page Quick Surface Reconstruction Version 5 Release 13



Scan and Curve Creation
You can use the following tools to create scans or curves: 

Project Curves
Planar Sections

Create Free Edges
3D Curve or 3D Curve on scan

Curve from scans
Intersection
Projection

Refer to Selecting Using Multi-Output to find out how to display and manage the list of selected elements
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Projecting Curves
 

This task shows how to project curves on clouds of points or meshes. 

The action proposes options to:

project the curves perpendicularly onto a mesh (not available for clouds of points),

modify the projection direction, 

smooth computed scans directly into curves. 

Open the CurvesOnCloud1.CATPart model the from the samples directory. You can use either the cloud or the 
mesh.

1.  Click the Project Curves  icon . The curve projection dialog box is displayed.

2.  Select the curves to project and the target cloud or mesh.  
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Selection of curves has been improved. Curves can be selected: 
●     from the specification tree,

●     with a selection trap,

●     with the preselection navigator.

3.  If the target is a cloud of points, the projection is automatically computed along a direction.

If the target is a mesh, you can select the Projection type from the list:

 

4.  If the projection is computed along a direction, the direction proposed by default is the Z axis. You can 

choose another direction, using the contextual menu of the Direction field:

●     the Edit Components option let you enter the coordinates of the direction:
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●     The Compass Direction option takes the compass current orientation as the projection 
direction. If you want to change this direction, modify the compass orientation and re-select 
Compass Direction to take the new direction into account.

●     otherwise, select one of the main axes as a direction.

5.  If the target is a cloud of points, you may set the working distance: the input curve is discretized, and 

each discretization point is projected on the cloud. The working distance is the distance taken into account 

around each projection point to compute the output scan. Enter 10 then 3 :
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6.  You can set a sag value: the curve to project is discretized according to this sag value, and each 

discretization point is projected on the mesh. In the example below, the sag was set to 1, then to 0.01:

 

7.  If you want to create curves, check the Curve creation option. The operating mode is the same as for the 

Curve from Scans action except that only the curvature comb is displayed, instead of the complete 

curvature analysis.
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●     If the Curve creation option is checked, curves and only curves will be created.

●     If the Curve creation option is not checked, scans and only scans will be created.

●     If you need a complete curvature analysis of the curves you create, you have to create the scans first, and 
then create the curves with the Curve from Scans action.

●     When you modify a parameter, click Apply in the corresponding dialog box to take it into account.

8.  Click Apply to check or update the result. Then click OK to confirm the result and exit the action. 

●     Scans are created in the specification tree under the name Curve Projection.x.

●     Curves are created in the specification tree under the name Curve.x.
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Cutting a Cloud of Points or a Mesh by Planar Sections
 

This task shows how to cut a cloud of points or a mesh by planes to compute scans and to smooth those scans directly to curves.

Open the Cloud.CATPart model the from the samples directory.

 

 

1.  Click the Planar Sections icon  and the cloud of points or the mesh. 

The Planar Sections dialog box is displayed with its default settings: 

❍     Number (of sections) is 1

❍     Step: it is computed on L1 the largest dimension of the containment box, and is equal to L1/50 rounded to the best suitable value.

❍     The plane of the section is parallel to the main plain of the compass. The section is distant from one step from the origin of the containment box.

❍     The Scans option is set to Grouped.

The Number option is modal.
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2.  Use the Plane Definition   icons to select the reference plane according to your need:

●     push the YZ  or XZ  or XY  icon to select a predefined plane, or

●     push the compass icon  to orient the reference plane with the compass, or

●     push the plane icon   to select an existing plane or 

●     One manipulator is available on the reference plane. It can be used to position the reference plane either by dragging the manipulator or by using the contextual menu Edit.

●     Another manipulator is available on the last cutting planes proposed. This manipulator is used to modify either the step between cutting planes, or the number of planes, depending 
on the option selected in the Fixed field or in the contextual menu attached to this manipulator.

●     Check the Keep this point option on any of those manipulators to create the corresponding point.
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Push the section guide icon  and select a curve: the sections will be perpendicular to this curve. The degree of the section guide must be greater than 2. 

3.  After setting the orientation of the reference plane, you can move it along its normal or along the section guide by dragging the center of the green manipulator in the required direction. 

4.  If required, you can select one or two limiting curves for any of the plane option. Pick the first limiting curve, its name is displayed in the First curve field. You can then select a second limiting 

curve. Its name is displayed in the Second curve field. 

The limiting curves should lay on the cloud of points or the mesh.

The section guide curve can be selected as second limiting curve (not as the first).

To replace a limiting curve by another, uncheck the corresponding field: the name is erased. Check the field again and select the new curve. Its name is displayed.

When using a limiting curve, the scans may be created on the "wrong" side of the curve. In fact, this side is determined by the origin of the reference plane. So move the reference plane to create the 
scans on the "right" side, either with the contextual Edit menu of the plane, or using the compass.
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The computation of sections with limiting curves has been improved:  
●     You no longer need to check the Lock Privileged Plane Orientation Parallel to  Screen option of the compass.

●     But be careful to choose a view parallel to the screen.

This enhancement enables you to define planar sections with the compass while using limiting curves.

For an easier selection of curves, you can use the pre-selection navigator (see the Infrastructure User Guide for more information). 

5.  Cutting planes can be defined :

 

either from the step (distance) between two consecutives planes: 

●     check Fixed, Step,

●     then enter the value of the Step in the dialog box,

●     and enter the Number of planes in the dialog box or drag  the green arrow until you reach the required number of planes (the dialog box is updated automatically).

 

or from  their number :
●     check Fixed, Number,

●     then enter the Number of planes in the dialog box,

●     and enter the Step between two planes or drag the green arrow until you reach the required step (the dialog box is updated automatically).
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You can also check  the Infinite option, especially when dealing with large models. In that case, the planes displayed on screen are used only to position the reference plane and define 
the step between two planes, if it is not fixed. The system computes all the cutting planes necessary to cut the whole model.

6.  The Influence Area parameter defines a computation area around the cutting planes: when the points are not dense, a cutting plane (black line) may be unable to intersect the points. The 

Influence area is the area shown in yellow that contains the points considered to intersect the cutting plane. You can define its value according to your needs.
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7.  Select the type of the result scans: either :

Distinct: the intersections are created as as many Planar Sections elements in the specification 
tree. 

Grouped: the intersections are created as one cloud (one Planar Sections element) in the 
specification tree.

:

8.  If you want to create curves, click Apply in the Planar Sections dialog box to display a scan in the specification tree and check the Curve creation option. The operating mode is the same as 

for the Curve from Scans action except that only the curvature comb is displayed, instead of the complete curvature analysis.

 

●     If the Curve creation option is checked, curves and only curves will be created.

●     If the Curve creation option is not checked, scans and only scans will be created.

●     If you need a complete curvature analysis of the curves you create, you have to create the scans first, and then create the curves with the Curve from Scans action.

●     When you modify a parameter, click Apply in the corresponding dialog box to take it into account.
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9.  Click Apply to check or update the result. Then click OK to confirm the result and exit the action.

Although cutting a cloud of points is quicker (no need to mesh first), creating planar sections on a mesh rather than on a cloud of points has some advantages: 
●     the action is dynamic on meshes: no need to apply to visualize the modifications (position of the reference plane, step, number of planes,...), 

●     In the case of a cloud of points, the intersection may be interpolated, since the plane does not necessarily intersect points. That problem is reduced with meshes since the plane intersects facets, 
providing a better accuracy.

   

●     if you process an hybrid CloudsUnion element made of a mesh and a cloud of points, the planar sections will be created on the mesh only.

●     The scans are created in the specification tree, as Planar Sections.x.

●     The scans created are ordered.

●     Scans can then be exported to an ASCII file.
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Creating Free Edges
This task shows you how to create scans or curves by creating the free edges of a mesh. 

You can:

●     create scans on all the existing free edges, or only selected free edges,

●     create scans on the whole free edge or only a portion of it, and select which portion,

●     create curves directly from these scans and check their curvature if required.

●     This action is available for meshes only!

●     This action is available on a complete mesh or on a portion of it .

Open the FreeEdges1.CATPart from the samples directory

1.  Click the Create Free Edges icon  and select a mesh. The dialog box is displayed and scans are 

proposed in cyan.

2.  Select the scans to process.

By default, all computed scans are proposed. Place the cursor on a label Selected and right-click 
to launch the contextual menu.
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You can:

●     Select or deselect singles scans,

●     Select or deselect all scans.

3.  If necessary, pick two points on a selected scan to define a portion of scan to create. Both extremities 

of the scan are displayed, together with its direction (as a red arrow). You can invert this direction by 

clicking on the red arrow.

Proposed direction, Before 
Apply

After Apply Inverted direction, Before 
Apply 

 

After Apply
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4.  To remove one extremity point, right-click on its label to start the contextual menu:

●     Click Apply to apply any change you make. 

●     If you want to create scans, check the required option: 

❍     Distinct to create distinct scans,

❍     Grouped to create one single scan.

●     If you want to create curves, check the Curve creation option. The operating mode is the same as for the 

Curve from Scans action except that only the curvature comb is displayed, instead of the complete 

curvature analysis.

 

●     If the Curve creation option is checked, curves and only curves will be created.

●     If the Curve creation option is not checked, scans and only scans will be created.

●     If you need a complete curvature analysis of the curves you create, you have to create the scans first, and 
then create the curves with the Curve from Scans action.

●     When you modify a parameter, click Apply in the corresponding dialog box to take it into account.
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Creating Associative 3D Curves 
This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points 
or passing points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element 
and the later is modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> 
Options -> Mechanical Design -> Assembly Design -> General tab.

  
 

●     Selecting 3D points

●     Editing

●     Keeping a point

●     Imposing a Tangency Constraint

●     Imposing a Curvature Constraint

●     Setting as Arc Limit

●     Removing a Point

●     Constraining a Point

  

Open a new .CATPart document.

1.  Click the 3D Curve icon .

The 3D curve dialog box is displayed.

2.  Choose the curve creation type.

Whatever the chosen type, the curve is 
previewed in dotted line as you move the 
pointer.

●     Through points: the resulting curve is a multi-arc curve 
passing through each selected point.
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●     Control points: the points you click are the control points 

of the resulting curve

●     Near points: the resulting curve is a single-arc, with a set 
degree and smoothed through the selected points.

 

You can edit the order by right-clicking the 
displayed text (displayed using the U, V Orders 

icon  from the FreeStyle Dashboard or the 

Order option from Tools -> Options menu, 
Shape -> FreeStyle -> General tab), and 
choosing a new order value.

The Automatic order option enables you to automatically 
compute an order that will respect at best all the curve 
constraints.
The computed value is displayed near the Auto tag.

   

●     The Deviation option enables the user to set the 
maximum deviation between the curve and the 
construction points.

The result is a set degree through the selected 
points.
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●     The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points 
and are inserted into the curve automatically.
The minimum value is set to 1.

●     Smoothing options are now available to parameterize the 
curve:  

●     Chord Length (default parameterization)
Smoothing parameter = 0

●     Uniform
Smoothing parameter = 0

 
●     Smoothing parameter: enable a better 

control points distribution of the smoothed 
curve.  

 

 Smoothing parameter = 50 Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.
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3.  Move the pointer over a point.

A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.

A contextual menu proposes several options to construct the 3D curve.

Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the 
Tuner dialog box and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency 
constraint on the curve at this point. 

 
4.  Click the Insert a point icon  within the dialog 

box.

The curve freezes.

5.  Click the segment, between two existing points where 

you wish to add a new point and click the point 

location.

 

Once the point has been created, you are back 
to the edition capabilities on the curve.

6.  Click the Remove a point icon  within the dialog 

box, and select one of the existing points.

The curve is recomputed immediately without the 

selected point.

7.  Click the Free or constrain a point icon  within the dialog box, then select the point.
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●     If the point is a point in space (free), move the pointer 

close to the point or a wire to which it should be linked. 

You can then move the pointer over a geometric element 

and: 

❍     move the point to the indicated point by clicking

❍     press and hold the Control  key (Ctrl) to project this 

point onto this element according to the shortest 

distance from the point initial location.

●     If the point was lying on another point or a wire (curve, 

line, spline, and so forth), it is freed from its constraint 

onto this element, and can be moved to any new location 

in space.

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but 
not constrained. It can be moved using the manipulators. 

8.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●     You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point 
where the end point lies, then move the end point to a new location.

●     The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. 
Therefore you can change creation planes within the same curve, by setting a new current plane/compass orientation on 
several points.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric element yet 
without constraining it onto the existing geometry.

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

   

Selecting 3D points

It is possible to select a scan of cloud either in the 
specification tree or directly in the geometry. 

The Select all points contextual menu is available within the 
3D curve action only, i.e. it is not available when you select 
the scan before entering the action but appears when the 3D 
Curve dialog box is open.

●     In the specification tree: 
❍     select the geometrical set just by clicking it, or

❍     right-click the geometrical set and choose Select all 
points in the geometrical set from the contextual 
menu, or
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❍     select a point in the geometrical set, right-click it and 
choose Select all points in the geometrical set from the 
contextual menu.

●     In the geometry: select a point, right-click it and choose 
Select all points in the geometrical set from the contextual 
menu.

   
 

Contextual Options
 

 

Double-click your curve, right-click on the manipulator to 

display the contextual menu.

 

According to the creation type, the following options are available:

 Through Points Control Points Near points

Edit X X X

Keep this point X X X

Impose Tangency X  X 

Impose Curvature X  X

Set as Arc Limit   X

Remove this point X X X

Constrain this point X X X

Editing

1.  Right-click any of the manipulators, and choose the 

Edit contextual menu to display the Tuner dialog box. 

This option allows you to redefine the tangency 

position, and its vector's step.

 

      

56Page Quick Surface Reconstruction Version 5 Release 13



 

The Relative check box enables you to redefine the tangency 
relative position, and its vector's step.
The Reset Origin button allows you to reset the origin of the 
relative position.

Keeping a point

1.  Right-click an existing point and choose the Keep this 

point menu item to create a point at this location. 

A Point.xxx appears in the specification tree.

You can create a Point.xxx either on each control point 

or on the selected control points. 

Imposing a Tangency Constraint
Automatic Constraint

●     When a curve is created in Through points or Near 
points mode, and its first point is constrained on any point 
of another curve, the new curve automatically is tangent to 
the curve on which its first point is constrained. As soon as 
the curve's second point is created, the imposed tangent is 
displayed on the new curve.
To deactivate the default option, uncheck the Impose 
Tangency contextual menu on the tangent vector. 

Tangency Constraint on Points
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When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the 
point at which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the 
point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points: 

●     In Through points mode: tangency can be imposed on any point

●     In  Near points mode: tangency can be imposed independently on each end points only

●     In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as 
described in step 7 above. See also Constraining a Control Points Curve.

 Here is how to do it:

Open the 3DCurve1.CATPart document.

1.  Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose 

the Impose Tangency menu item.

Two sets of manipulators are displayed: 
●     two arrows representing the normed directions (vectors) of 

the tangency

●     circles representing manipulators for this vector

You can also modify the tangency constraint by: 
●     pulling the arrow

●     gliding the circles

●     double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then 
dragging the mouse.

Right-clicking on any of the manipulators, you can also choose 
to define the constraint according to an external element: 

●     Use current plane orientation (P1)/Use compass 
normal (P2): the tangency constraint is defined in relation 
to the normal to the current plane, possibly defined by the 
normal to the compass main plane
When several points are constrained on the compass, all 
are modified if the compass settings are changed.
When this option is checked, the direction cannot be 
modified directly using the vector manipulator, but only 
using the compass.
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●     Constrain on element: available only when a point is 
already constrained on a curve. The curve being 
created/modified becomes constraint in tangency or 
curvature to the constraining curve at this point.

❍     Tangency constraint: in this case you can only modify 
the vector's norm using the Edit contextual menu, and 
no longer the vector's direction, the latter being 
defined by the constraining curve.
Click the arrow to invert the tangency direction if 
needed.

❍     Curvature constraint: in this case you neither modify 
the vector's norm using the Edit contextual menu, nor 
the vector's direction, the latter being defined by the 
constraining curve.

By default, when the tangency vector is constrained onto another curve, its initial direction is retained.

●     Snap on elements: the vector's direction is defined by an 
external element. Grabbing a manipulators, you drag the 
pointer over a curve, and the curve becomes tangent to 
the curve detected by the pointer. 
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If the pointer is over a point the direction is 
computed as the line going from the 
constrained point and the detected point.
If the pointer is over a plane, the tangency is 
defined by the normal to this plane.  

●     When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected 
element and the vector's norm.

●     Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over 
geometric elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around 
to recover the curve preview indicating that you are ready to create a new point.
Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end 
points on another curve, as described in step 7 above. 

When setting a constraint on an end point, a text is displayed 
indicating the type of continuity between the two curves.

Right-click the text to display the contextual menu from which 

you can choose another continuity type: tangency, or 

curvature.
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Note that: 
●     in Point continuity, only the selected point is constrained

●     in Tangent continuity, the selected point and the next one are constrained

●     in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining 
element, using the manipulators. However, you cannot constrain these points, because they are considered as already 
constrained. If you try to do so, a warning message is displayed. Nevertheless, you can add/remove points directly after the 
constrained end point, and the system resets the points as second and third points to be affected by the constraint, where 
applicable.

A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set 
constraint.

Imposing a Curvature Constraint

Right-click an existing point and choose the Impose 

Curvature menu item. An arrow representing the curvature 

direction (vector) is displayed. Modifying the vector direction 

modifies the curvature direction.

The direction of the curvature is constrained in the plane 

defined as normal to the tangent vector.

 
●     To impose a curvature continuity, you must ensure that a 

tangency continuity already exists.

●     This option is only available for the Through points and 
Near Points creation type.

 

Setting as Arc Limit

Right-click an existing point and choose the Set As Arc Limit 

menu item to start/stop an arc limit on this point. The curve 

will pass through this point.

This option is only available for the Near points creation type.

  

You can use standard shortcuts (Ctrl and Shift keys) to select, multi-select, and de-select any combination of control points on 
these curves.
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Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary 
analysis, auto detection (except for Snap on Control Point option), attenuation, and furtive display.
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Creating Associative 3D Curves on a Scan of Cloud

This task explains how to create a 3D curve on a scan of cloud:

●     either before entering the 3D curve action. In that case, you can select only one scan, 

●     or after entering the 3D curve action. In that case, you can select one or several scans.

●     either graphically. In that case, use the contextual menu Select all points to create a 3D curve on all the 
points of the scan,

●     or from the specification tree. In that case all points of the scan are taken into account even if you do not 
activate the Select all points menu.

Open the ScanOnCloud1.CATPart document.

1.  Click the 3D Curve 

icon .

The 3D curve dialog 

box is displayed.

2.  Choose the curve 

creation type.

Whatever the chosen type, 
the curve is previewed in 
dotted line as you move the 
pointer.

●     Through points: the 
resulting curve is a multi-
arc curve passing 
through each selected 
point.

●     Control points: the 
points you click are the 
control points of the 
resulting curve

●     Near points: the 
resulting curve is a single-
arc, with a set degree 
and smoothed through 
the selected points.
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3.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

4.  Double-click your 
curve, right-click on 
the manipulator to 
display the contextual 
menu. 

Please refer 
to the 
Creating 
Associative 
3D Curves to 
get the 
corresponding 
information.

It is now possible to select a scan on cloud before entering the 3D curve creation dialog box. To do so, click the 
Scan on Cloud in the specification tree and click the 3D Curve icon.

Selecting a scan of 
cloud

It is possible to select a scan of cloud either in the specification tree or directly in the cloud from the contextual menu: 

The Select all points contextual menu is available within the 3D curve action only, i.e. it is not available when you select the scan 
before entering the action but appears when the 3D Curve dialog box is open.

●     Right-click the Scan on 
Cloud.xxx in the 
specification tree and 
select Select all points.
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●     Right-click the cloud and 
select Select all points.

 

Here is an example with Through Points

Only scans of the type "scan on cloud" can be selected since other types of scans might contain too many 
points. 

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●     The creation plane for each free point is defined according to the current plane/compass orientation on the 
previous point. Therefore you can change creation planes within the same curve, by setting a new current 
plane/compass orientation on several points.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric 
element yet without constraining it onto the existing geometry.

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

For further information on the proposed Options, please refer to Creating Associative 3D Curves. 

You can use standard shortcuts (Ctrl and Shift keys) to select, multi-select, and de-select any combination of 
control points on these curves.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, 
temporary analysis, auto detection (except for Snap on Control Point option), attenuation, and furtive display.
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Curves from Scans
This task shows how to create curves from a scan or a set of scans. 

The Curve from Scans action tries to create curves 

●     with the defined tolerance, 

●     with the least possible  number of segments of the least possible order.

The Curve from Scans action proposes a dynamic definition of split points.
  

Open the CurveFromScan1.CATPart model from the samples directory.

For a better understanding, some images below show only one scan.

1.  Select the Curve from scans icon  and a set of scans.  The Curve from Scans dialog box is displayed. 

The scan is displayed in the "Polyline+Point" mode with the current graphic symbol. By default, the end points are fixed.

 
●     Scan modifications are not dynamic. You have to click on Apply to take new parameter values into account.

●     The scans can be selected in the specification tree.
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2.  Make sure the Smoothing Creation mode is checked.

3.  Click Apply. A temporary curve is displayed in white, indicating the tolerance is met.

4.  Change the Split Angle value to 60. A Split point is automatically inserted at the angle.

5.  Push the  icon to display the curvature analysis:
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6.  Release the  icon and now push the  icon to display the maximum deviation and the  icon to display the order and the number of segments:

7.  Click OK to exit the action and create the curve(s). Curve.x elements are created in the specification tree. The segmentation display is erased.

 
Parameters
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Creation mode

Two creation modes are proposed: 

●     Smoothing or 

●     Interpolation.

 

In the Smoothing creation mode, the curve is created by smoothing all the points between two split points.

 
Three parameters are available in this mode:

●     Tolerance,

●     Max. Order,

●     Max. Segments

  
Tolerance is the maximum distance between the curve and the points. 

●     Decrease the value of Tolerance to reduce that distance. 

●     You can check the distance between the curve and the points with the  icon. 

●     If the tolerance is met, the computed curve is displayed in white. If the maximum deviation display is activated, the maximum error is displayed in green.

●     Otherwise, the computed curve is displayed in red. If the maximum deviation display is activated, the maximum error is displayed in red.
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Max. Order is the maximum order of the curves created, i.e. the number of control points of those curves. 

  
 Max.  Segments which is the maximum number of spans between two cutting points.
  

The Curve from Scans action tries to create curves with the defined tolerance, with the least possible  number of segments of the least possible order. I.e.:
●     the action tries to create a curve with one segment of order 2. 

●     If the tolerance is not reached, the order of the segment is increased up the the Max. Order value. 

●     If the tolerance is not yet reached, the number of segments is increased, the segments having the least possible order. This order is increased to meet the tolerance, then the number of segments, and so 
on until both the maximum order and the maximum number of segments are reached. 

You can check the segmentation and the order of the curves with the  icon.
  
  

 
 In the Interpolation mode, the curve is created by interpolating the points of its support scan.

No parameters are proposed for this mode
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Visualization and Analysis icons

Three visualization icons are available:   

 analyzes the curvature of the resulting curves:

●     This is a temporary analysis, no analysis element is created in the specification tree.

●     Click on More to display more analysis options.

●     Click on Less to display the quick analysis options

●     More information is available in the Curvature Analysis section.

 

 displays the maximum deviation (not available for the Interpolation mode):
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The label is green if the tolerance is met, otherwise it is red.

 displays the order and the number of segments (not available for the Interpolation mode):

When the curve computed is segmented, the segmentation is displayed with blue x symbols. This color and symbol are not editable. 

 

 
Push the icons to activate the display, release the icon to erase the display. Those three displays can be combined together.

  

Split angle

A split angle is proposed by default at 90 degrees. This value is editable. Whenever the computed curve forms an angle greater than this value, it is split automatically into two curves. The split spot is 

displayed and two curves are created. 

 
If you modify the split angle value after having computed curves and before having validated them, the display of the computed curves is updated.
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You can also:

●     add split points by picking points of the scan.

●     or move a split point to another point of the scan: 

●     pick the split point you want to move: press the control key and the left-click on the label of the split point, 

●     with the control key and the left button of the mouse still pressed, drag the split point to the required scan point and drop it there.

The default constraint on a split point is "Point", i.e. passage. Click on the green label to change it to "Tangent". A second click will return it to "Point". 

You can also use the Impose tangency of the contextual menu of the constraint.

This contextual menu can also be used to remove one split point or all split points.

  
 

End points

End points propose more items in their contextual menu.
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 You can remove the extremity point of a computed curve, and replace it with a new or existing split point.
  
 Remove the end point: The end point is removed: Pick a point on the scan: Click Apply to visualize the new curve:

 

You can free or constrain the end points by checking the appropriate option in the contextual menu.

 

Label Meaning  

O O O Not available Free The extremity is free

X O O Not available Fixed
The extremity is fixed, it is 
the scan extremity (this is 
the option by default)
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X O X Not available Fixed on 
element

If the element is a point, 
the extremity of the curve 
is this point, not the scan 
extremity 

See constrain on element

     

If the element is a curve, 
the curve extremity is the 
nearest extremity of the 
constraining curve 

See constrain on element

     

If the element is a plane, 
the curve extremity is the 
point of the plane nearest 
to the scan extremity 

See constrain on element

X X O Available Fixed and 
tangent

The tangency direction is 
given by a vector going 
through the first (or the 
last) two points of the 
scan.
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X X X Available
Fixed and 

tangent  on 
element

The extremity is fixed and 
tangent to the constraining 
element. 

See constrain on element

O O Y Not available Free on 
element

The extremity is free and 
depends on the element. 

See constrain on element

O X O Available Free and 
tangent

The extremity is free.  The 
tangency direction is given 
by a vector going through 
the first (or the last) two 
points of the scan.

O X X Available
Free and 

tangent on 
element

The extremity is free and 
depends on the element. 
The tangency direction is 
given by the element 
(plane or curve). 

See constrain on element
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Constrain on element: 

The extremity of the curve computed is the scan extremity, unless the Constrain on element option is checked.

●     If the constraining element is a point, the curve extremity is that point,

●     if the constraining element is a curve, the computed curve extremity is the nearest extremity of the constraining curve,

●     if the constraining element is a plane, the curve extremity is the orthogonal projection of the scan extremity on to the plane.

If an extremity is constrained on an element, and if a tangency is imposed, the tangency direction is given by:

●     the tangent vector of the curve on the constraining curve extremity,

●     or the normal to the constraining plane.

Whenever the Impose tangency is checked, you can modify the tangent vector with the following box (Edit tangent in the contextual menu):  

●     It  is useful to impose a tangency constraint at the extremities if you intend to reconstruct a part in two steps:  
❍     reconstruction of the first half of the part,

❍     recovery of the whole part by performing a symmetry.

The tangency constraint will ensure that the two halves fit perfectly.

●     Only the tangency direction is taken into account, the norm is not.

This option is available in the Curve from Scans action only.
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Creating Intersections 

This task shows you how to create wireframe geometry by intersecting elements.

You can intersect:

●     wireframe elements

●     surfaces

●     wireframe elements and a surface.

Open the Intersection1.CATPart document.

 
1.  Click the Intersection icon .

 The Intersection Definition dialog box appears as well 
as the Multi-Selection dialog box allowing to perform 
multi-selection. 

 

2.  Select the two elements to be intersected.

The intersection is displayed.

 

Multi-selection is available on the first selection, meaning you can select several elements to be intersected, but only one 
intersecting element.

3.  Choose the type of intersection to be displayed: 

●     A Curve: when intersecting a curve with another one

 

●     Points: when intersecting a curve with another one
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●     A Contour: when intersecting a solid element with a surface

●     A Face: when intersecting a solid element with a surface (we 
increased the transparency degree on the pad and surface)

4.  Click OK to create the intersection element.

This element (identified as Intersect.xxx) is added to the specification tree. 

This example shows the line resulting
from the intersection of a plane and a surface

This example shows the curve resulting
from the intersection of two surfaces

  

Several options can be defined to improve the preciseness of the intersection.

Open the Intersection2.CATPart document.

●     The Extend linear supports for intersection option enables you to extend the first, second or both elements. 

Both options are unchecked by default.

 

Here is an example with the option checked for both elements.

79Page Quick Surface Reconstruction Version 5 Release 13



 
●     The Extrapolate intersection on first element check box enables you to perform an extrapolation on the first selected element, in 

the case of a surface-surface intersection. In all the other cases, the option will be grayed.

 

 Intersection without the Extrapolation option checked Intersection with the Extrapolation option checked
 

●     The Intersect non coplanar line segments check box enables you to perform an intersection on two non-cutting lines. In all the other 
cases, the option will be grayed.

 When checking this option, both Extend linear supports for intersection options are checked too.
 

 Intersection between the light green line and the blue line: the 
intersection point is calculated after the blue line is extrapolated

Intersection between the pink line and the blue line: the intersection is 
calculated as the mid-point of minimum distance between the two 

lines
  

●     Avoid using input elements which are tangent to each other since this may result in geometric instabilities in the tangency zone.

●     If you intersect closed surfaces, they need to be created in two different geometrical sets.

 
The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Creating Projections

 

This task shows you how to create geometry by projecting one or more elements onto a  support. The 
projection may be normal or along a direction.
You can project: 

●     a point onto a surface or wireframe support

●     wireframe geometry onto a surface support

●     any combination of points and wireframe onto a surface support.

Generally speaking, the projection operation has a derivative effect, meaning that there may be a 
continuity loss when projecting an element onto another. If the initial element presents a curvature 
continuity, the resulting projected element presents at least a tangency continuity. If the initial element 
presents a tangency continuity, the resulting projected element presents at least a point continuity.

Open the Projection1.CATPart document.

1.  Click the Projection icon  .

 The Projection Definition dialog box appears 
as well as the Multi-Selection dialog box 
allowing to perform multi-selection.

 

   

2.  Select the element to be Projected.

You can select several elements to be 
projected.  In this case, the Projected field 
indicates: x elements
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3.  Select the Support element. 

4.  Use the combo to specify the direction type for  the 

projection:

●     Normal: the projection is done normal to the support 

element.

●     Along a direction: you need to select a line to take its 
orientation as the translation direction or a plane to 
take its normal as the translation direction.

You can also specify the direction by means of X, Y, Z 
vector components by using the contextual menu on the 
Direction field.

●     Whenever several projections are possible, you can select the Nearest Solution check box to keep 
the nearest projection.
The nearest solutions are sorted once the computation of all the possible solutions is performed.
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●     You can smooth the element to be projected by 
checking either: 

❍     None: deactivates the smoothing result

❍     G1 : enhances the current continuity to tangent 
continuity

❍     G2 : enhances the current continuity to curvature 
continuity

●     You can specify the maximum deviation for G1 or G2 

smoothing by entering a value or using the spinners. 

If the element cannot be smoothed correctly, a warning 

message is issued.

Moreover, a topology simplification is automatically 

performed for G2 vertices: cells with a curvature 

continuity are merged.

5.  Click OK to create the projection element.

The projection (identified as Project.xxx) is added to the specification tree. 

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Selecting Using Multi-Output
This capability enables to keep the specification of a multi-selection input in a single operation.
It is available with the following functionalities:

●     Intersections

●     Projections

●     All transformations: translation, rotation, symmetry, scaling, affinity and axis to axis

●     Developed wires (Generative Shape Optimizer)

Let's take an example using the Projection and Translation functionalities.

Open the Multi-Output1.CATPart document.

1.  Click the Projection icon  .

The Projection Definition dialog box appears, as long 
as the Tools Palette toolbar.

2.  Select Translate.1 as first element to be 

Projected.

   
 

3.  Click the bag icon  to display the elements 

list.

The Projected dialog box opens.

4.  Select as many elements as you need for 

your projection. 

5.  Click Close to return to the Projection 

Definition dialog box.

The number of selected elements is 

displayed Projected field.
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Use the Remove and Replace buttons to modify the 

elements list.

     

6.  Select Extrude.1 as the Support element. 

7.  Select Normal as Projection type.

8.  Click OK to create the projection elements.

 

The projection is identified as Multi Output.1 
(Project) in the specification tree.

The created elements are aggregated under Multi 
Output.1.

You can create several multi-outputs in the specification tree, each one grouping one type of elements.

9.  Click the Translate icon .

The Translate Definition dialog box appears. 
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10.  Select Translate.1 and Translate.2 as the 

Elements to be translated.

11.  Select Direction, distance as the Vector 

Definition.

12.  Select Extract.2 as the Direction.

13.  Select -50mm as the Distance.

14.  Click OK to create the translated element.

The translation is identified as Multi Output.2 
(Translate) in the specification tree and appears 
below Multi Output.1. 

The created elements are aggregated under Multi 
Output.2.

 
When one or several features are in error under a multi-output (during creation or edition), an error 

message is issued after clicking Preview or OK and displays all features in error.

You are able to manually delete or deactivate the feature(s) in error. When editing the multi-output, 

deactivated features are not displayed.

You can now deactivate the all the elements of a multi-output. As a consequence, the multi-output 
disappears from the 3D geometry and no more features in error can be generated.
Similarly, you can activate all the elements of a deactivated multi-output.

 To have further information on deactivation, please refer to the Deactivating Features chapter.
  
 

●     Multi-selection is available when editing a single feature: double-click it in the specification tree and 
click the bag icon to replace it or add new elements.
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 ●     Multi-outputs and elements aggregated under a multi-output can be edited separately, simply by 
double-clicking it in the specification tree. Elements can be modified (added, replaced, or removed): 
the corresponding multi-output automatically updates.

 Unshared features are aggregated under the parent command that created them and put in no show in 
the specification tree.
Shared features are not aggregated under the parent command.

 
●     The Datum capability is available. If an element is in error, it cannot be created as a datum element; 

only elements that could be generated from the multi selection are created.
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Domain Creation
 

You can use the following tools to create domains: 

Clean Contour
Adjust nodes
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CleanContour Creation

 

This task shows how to create a CleanContour.

A CleanContour is created from selected edges or curves, ordered or not, that are chained into an open or closed contour: 
●     Each input element is cleaned (burred or trimmed),

●     Continuity or fixity constraints are applied to those elements and taken into account during  the cleaning,

●     "Free" curves are sent to the NoShow and a new curve is created in the CleanContour.
"Fixed" curves (by default face edges or curves belonging to another CleanContour or a join) are not replaced by new ones and are integrated directly in the CleanContour. 

●     These curves are then chained to produce the CleanContour.

The CleanContour action sets the chaining order of the curves to create a contour. In some cases (especially with long curves) the chaining may lead to an unexpected result. You may need to slice 
curves or edges in order to solve this chaining incompatibility. For further information, see "Curves Slice ".

 

original curves: CleanContour impossible

 

sliced curves 

 

 

CleanContour 

 

Open the CleanContour1.CATPart from the samples directory
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1.  Click the CleanContour icon . The CleanContour dialog box is displayed.

2.  Select the curves. The default constraints are displayed on each curve. The curves are listed in the dialog box :

You can change them by simply clicking on the text or using the contextual menu.
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●     If you select a sliced surface edge, the constraint existing on the edge is not taken automatically into account. You have to restore it with the contextual menu.

●     You may want to select a join. If this join contains a sliced surface edge, or a split CleanContour that contains a sliced surface edge, with a tangency constraint that you want to keep, pick the 
curves one by one, graphically, i.e. do not select a join by picking one vertex, nor select the elements in the specification tree.

If you want to replace one curve by another, pick the curve to replace and then the new curve. 

There are several ways to modify the list of the elements selected:

a.  Pick the name of the curve you want to delete in the list of the elements selected in the dialog box.

b.  Call the contextual menu and click Remove. The curve is removed from the list, and is no longer highlighted in the graphic zone. This is useful when the curve to remove is 

too short to be selected graphically.

or
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a.  Use the Undo/Redo function to deselect the curves you have previously selected.

or

a.  Pick the curve in the graphic zone. It is removed from the list of the dialog box and is no longer highlighted.

If necessary, you can pick further curves to complete the selection. The dialog box is updated accordingly:

 

The Undo/Redo function is no longer available once you have used one of the two other methods.

The CleanContour computation is based on the minimum distance of the curves. The deformation allowed may not exceed the hole size. Priority is given to the parametric restriction over the 

deformation.

●     if the points of the minimum distance between two curves are no end points of the curves, the curves are restricted.

●     if the points of the minimum distance between two curves are end points of the curves, a point is computed on the segment corresponding to that minimum distance, weighted by the length of 

each curve :
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●     if only one end point of a curve is a point of minimum distance, this end point is moved to the point of minimum distance on the other curve.

3.  Check the Closed Contour option to close the contour, according to the rules above:
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4.  Check the Automatic Tangent Constraint to force a tangency constraint on the curve end points when the angle of the tangents at those ends is lower than the Max Angle G1 value.

5.  The curves are deformed to achieve a CleanContour. By default, this deformation is local:

 
Input curves

The deformation is local and not distributed along the whole curves.
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If you check the Global deformation option, the deformation is more evenly distributed on the whole curves. The degree and the structure of the curves are kept.

6.  Click Apply: a proposed CleanContour is displayed in green. Click OK to validate. A CleanContour.X body containing a Join.x element, the editable merging distance parameter and the 

hidden modified or deformed curves (input of the join) is created in the specification tree. The CleanContour is created, the input curves are hidden. 
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Curves Network
This task will show you how to create a network of constrained curves to be used in the surfaces network command.

On a first step, you have created characteristic curves on the cloud. These curves are often approximate and require some 
preparation:

●     Slicing that cuts curves or edges in several pieces, according to a pseudo-intersection: there is a pseudo-intersection between two 
curves if they intersect each other in the view direction (but not really), and if the mini 3D distance between them at this cutting 
point is lower than the parameter Max. Distance. 

Pseudo-intersection of two curves in the view direction 

 

in another view. 

 

 
●     Deburring to remove undesirable small curve pieces, based on a Min length criterion.

 Then, you can create a network from these cleaned curves according to the following:
●     A network is a set of closed and connected contours, named wires,

●     a contour is a set of connected edges, it is necessarily closed but not limited to 3 or 4 sides,

●     an edge belongs to one contour (free border edge) or 2 contours (common edge),

●     if there are no free border edges, the network is closed,

●     a node is the topological encounter point of two or more edges. These edges may belong to different contours.

Once the action has detected the topology (node, contours, free border edges), 

the curves are adapted to the network internal constraints such as:

●     Connection constraints on nodes (all edges ending on a common node must be connected on this point).
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●     Tangency constraints between two edges on a node. 

 
Open the SurfNetwork.CATPart from the samples directory.

1.  Click the Curves Network icon. The dialog box is displayed. It consists of 3 tab pages:

●     Preparation,

●     Constraints,

●     Freeze.

 
2.  Stay in the Preparation tab and select the curves to clean. They are displayed in the dialog box. 

You can select a CleanContour, a Curves network or a Join of curves, their curves will be added to the list.
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To remove a curve from the list:

●     pick the curve again in the graphic area, or

●     pick the curve again in the specification tree, or

●     pick the curve you want to remove in the list of the dialog box and use the contextual menu Remove.

You can also select additional curves, they will be added to the list.

  
 

3.  Select the mesh as the Support. Click Apply. 

Before computing the network, the action searches overlapping curves. If some are detected, a message is displayed:

The overlapping curves are displayed in magenta:
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The wires are then computed and displayed. The push button Deleting wire is now available.

 A wire is computed on each "loop" of curves, plus a large one on the "loop" formed by the external curves because the network is 
considered as closed by default. If your network does not form a closed volume, you usually do not need this large wire (it would 
create an additional surface as you create surfaces from the curves network). In the same way, you can remove wires corresponding 
to holes in your part.

4.  Push the Deleting wire button to activate the wire selection. The large wire is highlighted and a Delete wire button becomes 

available.

5.  Push the Delete wire button to remove this wire.
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●     In the cases where you want to create a surface on a network of curves with a hole in it, i.e. without filling one or several wires, 
use the Deleting wire button to activate the wire selection, select the wire by picking two of its edges, and push the Delete wire.

●     If you do not remove the large wire, an information message is displayed as you push OK.

 The parameters Max distance and Min length are those used in the Curves Slice command.

  
 

6.  Go to the Constraints tab to define constraints. The existing constraints are highlighted, as a green dot for continuity 

constraints on nodes, as a blue line for tangency constraints, as a red curve for fixed curves.

The constraints are applied globally on the whole network.
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Continuity constraints on nodes are implicit and can not be removed. 

The Node tolerance defines the maximum distance between edges extremities to consider these edges connected on a node. You can 
modify this value, but it can not be smaller than the Max distance parameter.

The Node tolerance is visualized as a green sphere whose radius is equal to the Node tolerance. The size of this sphere is updated 
when you modify the Node tolerance value. You can move the sphere using the cursor.

Tangency constraints are activated by the Automatic tangency check box. You can edit the value of the tangency angle. Push Apply 
after each modification.

 
 Check Projection on support to compute the network from the projections of the curves on the polygon. The curves projected are 

smoothed, with the Smoothing tolerance. This parameter can be edited. It is applied to all curves.

 
You can choose between a global or a local deformation constraint (available for all deformable edges). This constraint is applied during 
the geometric adaptation step. If the Global deformation checkbox is set, edges deformations are done along the entire length of the 
edges.

Example of global deformation:

Example of local deformation:

 
 Push the Default constraints to revert to the default constraints.

7.  Go to the Freeze tab page to select curves that must remain fixed.
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 Pick a curve to fix it. It is displayed in red in the graphic area and displayed in the dialog box. Pick it again or use the 
contextual menu Remove to free it.

 

●     You can freeze only curves that have been selected in the preparation tab.

●     An edge of a face is automatically and definitely fixed.

●     Free border edges are fixed by default but you can free them.

  
The action provides a constraint solver to search conflicts between constraints.

A message is displayed at the end of the search. When all constraints have been checked, conflicts are highlighted in magenta.
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Modify the constraints to solve the existing conflicts before creating the wires.

 
 

7.  Push OK to validate the network and exit the dialog box. A CurvesNetwork element is created in the specification tree.
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Surface Creation
This chapter deals with the creation of surfaces in Quick Surface Reconstruction.

Basic Surface Recognition
PowerFit

Creating Multi-sections Surfaces
Surfaces Network
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Basic Surface Recognition
This task shows you how to recognize the basic shapes of a part and how to create the corresponding 
editable surfaces.

Open the Canonic1.CATPart from the samples directory.  

 

1.  Click on the Basic Surface Recognition icon . The Basic Surface Recognition dialog box is 

displayed. 

2.  First identify visually the portions of the part made of the basic surfaces, i.e. planes, cylinders, 

spheres, cones. Then activate each of those portions in turn and let the application recognize and 

create the surface. The name of the cloud selected is displayed at the top of the dialog box.
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The Activate action is available within the Basic Surface Recognition action: 
●     Pick the cloud of points or polygon as you enter the Basic Surface Recognition action.

●     Start the Activate action and pick a cloud of points or polygon (the one you have previously picked or 
another if need be).

●     Activate the area you want to work on.

●     Exit the Activate action. 

●     Pick the area you have just activated and start the Basic Surface Recognition.

The portion of the cloud of points or polygon to recognize can also be activated before entering the Basic 
Surface Recognition. 

3.  Select the type of surface to detect or choose the Automatic option and click Apply to visualize 

the shape.

For each type of surface, you can choose to let the application compute the surface or you can set some 
data: 

●     For a plane: the normal to the plane and its passing point,

●     For a sphere: the center and the radius,

●     For a cylinder: the radius, the axis and the center,

●     For a cone: none,

●     For the automatic option: the maximum plane error.

Those data are also displayed in the dialog box when the surfaces are computed by the application. 

You can activate the corresponding fields by checking their names and edit the values as necessary before 
creating the surfaces. 
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●     If you choose a shape type to recognize, you can edit its geometric properties (Axis, Center, Radius) 
by activating the corresponding check boxes and entering new values.

●     If the shape recognized is a plane, you can edit it graphically, using the extension (arrows) and 
rotation (circle) manipulators.

●     If you choose the Automatic option, you can not modify the geometric properties of the shape 
directly. Once the shape has been recognized, check the corresponding shape type to make the 
corresponding properties editable.

●     Click Apply to take those modifications into account. 

4.  Check the Spike option to display the deviation between the canonic surface and the original part.
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5.  Push the More>> button to display the statistics on the action.

6.  Click OK to create the shape.

 

7.  Double-click the shape to edit it, if required: 
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The following features are created in the specification tree:

An extrusion element named 
Plane.x with its components, 

The normal to that plane named 
PlaneNormal.x and its 
components

A feature sphere named 
Sphere.x and its 
components
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An extrusion element named 
Cylinder.x with its 
components, 

The axis of that cylinder named 
CylinderAxis.x and its 
components.

 

A rotation element 
named Cone.x and its 
components, 

The axis of that cone 
named ConeAxis.x and 
its components.
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PowerFit

 

This task shows how to use PowerFit. 

PowerFit is used to create:

●     an untrimmed surface supported by one cloud of points or one polygon and/or curves,

●     a surface supported or not by one cloud of points or one polygon and trimmed by an external boundary.

 

Original polygon and boundary

 

Untrimmed surface supported by the polygon

 

Surface supported by the polygon 
and trimmed by the boundary

   The dialog box labels have been updated: Point Gap has been replaced by Tolerance and Number by Segments.

 
Open the PowerFit1.CATPart from the Sample directory. This model consists of a polygon (Polygon) and a join (Join.2).

1.  Click on the PowerFit icon . The dialog box is displayed:

This action is modal: the values used are re-displayed the next time you open this dialog box.

2.  Enter the polygon and/or the curves to process, set the constraints and parameters, click Apply to preview the result, and OK to validate it. A 
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Surface.x element is created in the specification tree. The segmentation display is erased.

Below, you will find explanations on: 

●     Input elements,

●     Constraints,

●     Parameters,

●     Information,

●     Counterdraft detection.

Input elements
●     Select the element(s) to be processed: 

●     either a cloud of points or a polygon or a portion of these,

●     or curves,

●     or both.

 

Clouds:

You may process only one cloud  or one polygon at a time. Once selected, it is sent in the NoShow space.
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Curves:

The curves form either a closed set of curves or an open set of curves with only one hole in it. You can make the curves continuous 
either during their construction or using the clean contour action.

You can either select a whole clean contour from the specification tree, or by picking one of its vertex (the clean contour is 
highlighted), or pick curves (the curves are highlighted).

If one curve of the clean contour is linked to a face, the tangency continuity is not proposed if you pick the curve. It is proposed if you 
pick the clean contour. 

Those input curves are not modified and are sent to the NoShow space.  

If a trimmed surface is created, the edges of the face will be the curves computed from the input curves.  

 

Closed set of curves

 

Open set of curves

 

Open set of curves with its topological closing 
line (no curve is created as such, but as the 

edge of the trimmed surface, if any)
This type of open set of curves is not 

accepted:

 

●     Check the Init Surface box if you want to enter one. The init surface helps the computation by giving the shape of the result surface. You can 

either enter it yourself or let the application compute it in the direction of the largest curve. If you select an init surface, its name is displayed in 

the field Init Surface.

The init surface must be larger than the domain to process.

●     Tolerance is the mean maximum deviation between the surface created and the cloud of points or polygon, i.e. the deviation may be higher at 

some places. This field is editable.

Constraints
●     Choose the way the input curves are taken into account: 

●     as Constraint: the computed surface will go through them,

●     Trim: the surface is computed, then the curves are projected onto it to trim it.

●     or Selection: the computation is based on the points located inside the curves.
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Continuity may be requested on the input curves regarding the surface to create:

●     G-1: free. Applies to the Trim or the Selection options. 

●     G0: point continuity. Applies to the Constraint option.

●     G1 : tangent continuity. Applies to the Constraint option.

By default, the continuity requested in the Join action are proposed by the PowerFit action. 

You can change them by simply clicking on the text or using the contextual menu.

 
●     You may want to select a join. If this join contains a sliced surface edge, or a split CleanContour that contains a sliced surface edge, with a 

tangency constraint that you want to keep, pick the curves one by one, graphically, i.e. do not select a join by picking one vertex, nor select the 
elements in the specification tree.

In short: Input Information Output

Points or polygons  The surface is computed on the points. 
It is not trimmed.

Miscellaneous curves No outer boundary.
No points. This case is not dealt with.

Miscellaneous curves + points No outer boundary.
Points. This case is not dealt with.

or

Curves (Outer boundary).
No points.

Option: Constraint
Possible constraints: G0, G1.

The surface is computed on the curves.
The curves become the edges of the 
surface.

or

Curves + points

Option: Selection
Possible constraint: G-1

The surface is computed on the points 
located inside the curves. The surface is 
not trimmed.

Option: Trim 
Possible constraint: G-1

The surface is computed on the points. The 
curves are then projected on the surface to 
trim it. 

Option: Constraint
Possible constraints: G0 or G1

The surface is computed on the points and 
the curves. The curves become the edges 
of the surface.
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Parameters
●     Order, Segments: 

These parameters apply globally to the surface computed. They are maximum values. The actual values are computed automatically 
by the action.

PowerFit creates a NURBS surface, controlled by the tolerance (i.e. Tolerance), the number of segments and their order. Whenever 
possible, this surface consists of one single segment, otherwise, it is made of several segments. This surface may then be trimmed by 
the curves.

You can increase the order of the segments, thus reducing their number, or vice-versa. 

If the number of segments is x, this means that the surface computed will consist of a maximum of x segments, or less. The default 
number of segments is 64, the maximum number is 2048. 

If the order of segments is y, this means that each segment will have a maximum number of y control points in each direction, or less. 
The segment order may vary from 3 to 15.

●     Advanced:

You may want to impose an order and a number of segments in both U and V direction. To do so, check Advanced. The Order and 
Segments fields above are no longer available. You can edit the fields below to :

●     enter the number of segments in each direction,

●     enter the order of segments in each direction,

●     swap the values in U and V.

Click Apply to restart the computation.

●     Increasing the order of the segments may result in an oscillating surface, even if this is not visible.

●     Push the Show Information button and check the Segmentation option to display the segmentation of the computed surface.

●     Gap: G0:  

this is the distance between the surface and the boundary curves. Since there is more noise on points than on curves, the Tolerance 
may be higher than the GO Gap. The default value is 1.
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●     Gap: G1:  

this is the tangency tolerance between two contiguous surfaces (in blue below). The default value is 0.5.

●     Tension: 

Possible values are between 0 and 4. Use a higher value to have a smoother (but less tense) surface.

 

Please note that since the shape is constrained by the points, the effect of this parameter is limited. 

●     Radius:  

when the cloud of points is noisy, it is difficult to have the surface going through all the points and the curves (risk of undulations). 
The points inside a circular pipe centered on the curve are deleted, and you may want to set the radius of that pipe.

When you check this option, a blue sphere is displayed on the extremity of the first curve, representing this radius (if you have 
selected at least one curve and a cloud of points or a polygon).
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If two curves are not distant enough, all the points between them may be deleted, making the computation of the surface impossible.

Information

Push the Show information button to check the required options and display statistics.

●     Check the Spikes option to display the deviations.

●     Check the Segmentation option to display 

●     the segmentation on the surfaces computed,

●     the number of segments and order in U,

●     the number of segments and order in V.

●     Use the Deviation field to enter the value above which the deviation spikes will be displayed. When you first enter the action, the Deviation 

value is the same as the Tolerance. Once a surface has been computed, the Deviation value is the computed one.

You must first click Apply to compute the surface and to display the deviation spikes.

●     You can use one or more edges of an existing surface to compute a new surface with PowerFit. Check the Connect Checker option to display the 

connection analysis between the existing surface and the new surface.
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The Connect Checker is not available on surface edges that have been previously sliced.

●     You must first click Apply to compute the surface and to display the connection analysis.

●     Click on OK or Cancel to exit the Quick Violation Analysis and return to the PowerFit dialog box .

●     Click on Full to display more analysis options.

●     More information is available in the Connect Checker section.

Information on the points for the parameters taken into account by the computation are available in the box at the bottom of the dialog box (no 
dynamic display):

●     the maximum deviation found between the points of the cloud and the surface,

●     the mean deviation found between the points of the cloud and the surface. This deviation should be as small as possible.

●     the standard deviation, i.e. the dispersion of the points around the mean deviation. A small standard deviation indicates that most points are 
within the mean deviation, i.e. that there are only few outliers.

●     the percentage of points of the cloud that are below the mean deviation.

Counterdraft detection
●     Generally, when a counterdraft or opposite points are detected, a message is displayed in the dialog box, and no surface is computed. You can 

solve the problem by activating a portion of the cloud of points and restarting the computation.

●     When PowerFit is used to compute a trimmed surface from the points of a cloud of points and curves that form the surface boundaries, these 
curves define a prismatic trap with infinite height and a view direction. The points used for the computation are all the points contained in this 
trap. Therefore, counterdraft or opposite points may alter the computation.

 
Counterdraft: Opposite points: 
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PowerFit can select the required points up to a certain level: 

●     This is possible with polygons, not with cloud of points.

●     All triangles considered belong to the same polygon and their orientation is coherent.

●     The points are separated into two zones, according to the direction of the normal of the triangles. This selection is easy in the above cases (the 
equator line is the separation between the two zones for the counterdraft, for the opposite points, the zones are already well delimited). The 
incorrect zone is not taken into account in the computation.

●     The selection is harder in such cases:

According to the normal of their triangles, the points belong to two zones, shown in black and in yellow in our example. The points surrounded in 
black form one zone, the points surrounded in yellow form another zone, both zones contain points that should not be taken into account. Such cases 
are not yet dealt with successfully.

●     In short, the points that PowerFit recognizes as unwanted for the computation are correctly eliminated. However, some points may still be taken 
into account, whereas they should not. This may lead to a defective result. In such cases, you should activate yourself the requested zone, with 
the Activation command.
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Creating Multi-sections Surfaces 

 

This task shows how to create a multi-sections surface and includes the following functionalities: 

●     Relimitation

●     Planar Surface Detection

●     Coupling

You can generate a multi-sections surface by sweeping two or more section curves along an automatically 
computed or user-defined spine. The surface can be made to respect one or more guide curves. 

 
Open the Loft1.CATPart document.

1.  Click the Multi-sections Surface icon  .

The Multi-sections Surface Definition 
dialog box appears.

2.  Select two or more planar section curves.

The curves must be continuous in 
point.

You can select tangent surfaces for 
the start and end section curves. 
These tangent surfaces must not be 
parallel to the sections.

A closing point can be selected for a 
closed section curves. 

Example of a multi-sections surface defined by three planar 
sections: 
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3.  If needed, select one or more guide curves.

Guide curves must intersect each 
section curve and must be continuous 
in point.

The first guide curve will be a 
boundary of the multi-sections 
surface if it intersects the first 
extremity of each sections curve.

Similarly, the last guide curve will be 
a boundary of the multi-sections 
surface if it intersects the last 
extremity of each section curve. 

Example of a multi-sections surface defined by 2 planar 
sections and 2 guide curves: 

 

You can make a multi-sections surface tangent to an adjacent surface by selecting an end section that lies on the 
adjacent surface. In this case, the guides must also be tangent to the surface. 

In Figure 2 a multi-sections surface tangent to the existing surface has been created:

Figure 1 Figure 2
You can also impose tangency conditions by specifying a direction for the tangent vector (selecting a plane to take 
its normal, for example). This is useful for creating parts that are symmetrical with respect to a plane. Tangency 
conditions can be imposed on the two symmetrical halves.
Similarly, you can impose a tangency onto each guide, by selection of a surface or a  plane (the direction is tangent 
to the plane's normal).  In this case, the sections must also be tangent to the surface.

4.  In the Spine tab page, select the Spine check box to use a spine that is automatically computed by the 

program or select a curve to impose that curve as the spine. 

Note that the spine curve must be normal to each section plane and must be continuous in tangency.
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You can create multi-sections surface surfaces between closed section curves. These curves have point continuity at 
their closing point.
This closing point is either a vertex or an extremum point automatically detected and highlighted by the system. 
By default, the closing points of each section are linked to each other.

The red arrows in the figures below represent the closing points of the closed section curves. You can change the 
closing point by selecting any point on the curve.  

The surface is twisted A new closing point has been imposed
to get a non-twisted surface

Extremum points are now aggregated under the 
parent command that created them and put in no 
show in the specification tree.

In the Smooth parameters section, you can check: 
●     the Angular correction option to smooth the 

lofting motion along the reference guide curves. 
This may be necessary when small 
discontinuities are detected with regards to the 
spine tangency or the reference guide curves' 
normal. The smoothing is done for any 
discontinuity which angular deviation is smaller 
than 0.5 degree, and therefore helps generating 
better quality for the resulting multi-sections 
surface surface.

●     the Deviation option to smooth the lofting 
motion by deviating from the guide curve(s).

123Page Quick Surface Reconstruction Version 5 Release 13



5.  It is possible to edit the multi-sections 

surface reference elements by first selecting 

a curve in the dialog box list, or by selecting 

the text on the figure, then choosing a 

button to either:

●     remove the selected curve

●     replace the selected curve by another curve

●     add another curve

More possibilities are available with the contextual 
menu and by right-clicking on the red text or on the 
object. For example, it is possible to remove and 
replace tangent surfaces and closing points.

 
The following example illustrates the result when the tangency condition is removed between the blue multi-
sections surface and the adjacent surface.
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6.  Click OK to create the multi-sections surface surface.

The surface (identified as Multi-sections Surface.xxx) is added to the specification tree.

●     Sections can be 3D curves with following restrictions: 
❍     the intersection between one 3D profile and all guides must be coplanar (if three guides or more are 

defined)

❍     in case of a user-defined spine, this spine must be normal to the plane implicitly obtained above.

Relimitation
The Relimitation tab lets you specify 
the relimitation type. (Open the 
Loft3.CATPart document).
You can choose to limit the multi-
sections surface only on the Start 
section, only on the End section, on 
both, or on none. 

a.  when one or both are checked: the multi-sections surface is limited to corresponding section
b.  when one or both are when unchecked: the multi-sections surface is swept along the spine: 

❍     if the spine is a user spine, the multi-sections surface is limited by the spine extremities

❍     if the spine is an automatically computed spine, and no guide is selected:
the multi-sections surface is limited by the start and end sections 

❍     if the spine is an automatically computed spine, and guides are selected:
the multi-sections surface is limited by the guides extremities.
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Multi-sections surface relimitation option checked
 on both Start and End section

Multi-sections surface relimitation option unchecked
 on End section only

After the multi-sections surface is relimited, the following constraint needs to be fulfilled: the plane normal to the 
spine defined at the relimitation point must intersect the guide(s) and the point(s) resulting from this intersection 
must belong to the section.

Planar Surface Detection
●     Use the Planar surface detection check button (Canonical Surfaces tab) to automatically detect planar 

surfaces to be used as planes for features needing one in their definition.

Initial multi-sections surface with planar faces Using a planar face as reference for a sketch

Resulting sketch

 

Coupling

 

This task presents the two kinds of coupling during the creation of the multi-sections surface surface: 
●     coupling between two consecutive sections

●     coupling between guides

These couplings compute the distribution of isoparameters on the surface.

 
Open the Loft2.CATPart document.
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Coupling between two consecutive 
sections

This coupling is based on the curvilinear abscissa.

1.  Click the Multi-sections Surface icon  .

The Multi-sections Surface Definition 
dialog box appears.

2.  Select the two consecutive sections.

3.  Click OK to create the multi-sections surface.

If you want to create a coupling between particular 
points, you can add guides or define the coupling 
type.

127Page Quick Surface Reconstruction Version 5 Release 13



Coupling between guides

This coupling is performed by the spine.
If a guide is the concatenation of several curves, the resulting multi-sections surface will contain as many surfaces 
as curves within the guide.
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Several coupling types are available, depending on 
the section configuration: 

●     Ratio: the curves are coupled according to the 
curvilinear abscissa ratio.

●     Tangency: the curves are coupled according to 
their tangency discontinuity points. If they do 
not have the same number of points, they 
cannot be coupled using this option. 

 
●     Tangency then curvature: the curves are coupled according to their tangency continuity first then curvature 

discontinuity points. If they do not have the same number of points, they cannot be coupled using this option. 

●     Vertices: the curves are coupled according to their vertices. If they do not have the same number of vertices, 
they cannot be coupled using this option. 

Manual Coupling

If the number of vertices differ from one section to another, you need to perform a manual coupling.
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1.  Select the sections for the multi-sections 

surface, and check their orientations.

2.  In the Coupling tab, choose the Tangency 

option and click Apply.

An error message is displayed as the 

number of discontinuity points on the 

first section is greater than on the 

other two sections.

The points that could not be coupled, are displayed 
in the geometry with specific symbol depending on 
the selected mode, along with coupling lines:

●     In Tangency mode: uncoupled tangency 
discontinuity points are represented by a square

 
●     In Tangency then curvature mode:  

❍     uncoupled tangency discontinuity points are 
represented by a square

❍     uncoupled curvatures discontinuity points are 
represented by a empty circle

●     In Vertices mode: uncoupled vertices are 
represented by a full circle

3.  Click in the coupling list, or choose Add 

coupling in the contextual menu, or using 

the Add button, and manually select a point 

on the first section.

The Coupling dialog box is displayed.
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4.  Select a corresponding coupling point on 

each section of the multi-sections surface.

The Coupling dialog box is updated 

consequently, and the coupling curve 

is previewed, provided the Display 

coupling curves option is active.

When a coupling point has been 

defined on each section, this dialog 

box automatically disappears.

5.  Click OK.

The multi-sections surface is created 
as defined with the coupling 
specifications.

The same multi-sections surface 
without coupling and with Ratio 
option would have looked like this:

Note the increased number of 
generated surfaces.
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●     You can create coupling point on the fly, using the Create coupling point contextual menu item (click on the 
document background to display the contextual menu) instead of selecting an existing point.

●     To edit the coupling, simply double-click the coupling name in the list (Coupling tab) to display the Coupling 
dialog box. Then you select the point to be edited from the list and create/select a replacing coupling point, then 
click OK.

●     Use the contextual menu on the coupling list to 
edit defined couplings.
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Surfaces Network
This task will show you how to create a surface on a curves network.

Create a network of curves from the SurfNetwork.CATPart from the samples directory.

1.  Click the Surfaces Network icon . The dialog box is displayed.

2.  Select the curves network you have created (mandatory), as well as the mesh as the Cloud.

It is not necessary to use a support Cloud or a Init Surface, but they may improve the output.

Check the Init Surface box if you want to enter one. The init surface helps the computation by giving the shape of the result surface. You can either enter it yourself or let the 

application compute it in the direction of the largest curve. If you select an init surface, its name is displayed in the field Init Surface.

The init surface must be larger than the domain to process.
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 The curves network is displayed, with a green V marker on each wire, meaning the wire will be filled.

You can fill all the wires automatically (this is the proposed default) or you can fill the wires one by one. 

If you do not want to fill a wire:

●     either click on its marker, it will turn into a red X marker. The wire will not be filled. (click the marker again to reselect the wire, if necessary),

●     or place the cursor on a marker and use the contextual menu: 

Selected and Not selected apply to a single wire, Select all and De-Select all apply to the whole network, Swap Selection reverses the selection. Remove Surface allow you to 
suppress a surface you are not happy with or that you prefer to fill later.

Constraints are set on edges shared by two wires. 

represents a point continuity

represents a tangency continuity

To change the type of a constraint:

●     either click on its marker. This will act as a toggle,

●     or place the cursor on a marker and use the contextual menu:
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Point Continuity and Tangent Continuity apply to a single constraint, All Point Continuity and All Tangent Continuity apply to the whole network.

You can set the following Parameters:

Tolerance is the mean maximum deviation between the surface created and the cloud of points or polygon, i.e. the deviation may be higher at some places. This field is editable.

Gap: G0:  

this is the distance between the surface and the boundary curves. Since there is more noise on points than on curves, the Tolerance may be higher than the GO Gap. The default 
value is 1.

 

Gap: G1:  

this is the tangency tolerance between two contiguous surfaces (in blue below). The default value is 0.5.
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Radius:  

when the cloud of points is noisy, it is difficult to have the surface going through all the points and the curves (risk of undulations). The points inside a circular pipe centered on the 
curve are deleted, and you may want to set the radius of that pipe.

When you check this option, a blue sphere is displayed on the extremity of the first curve, representing this radius (if you have selected at least one curve and a cloud of points or a 
polygon).

 

If two curves are not distant enough, all the points between them may be deleted, making the computation of the surface impossible.

136Page Quick Surface Reconstruction Version 5 Release 13



Tension: 

Possible values are between 0 and 4. Use a higher value to have a smoother (but less tense) surface.

 

Standard: Order, Segments: 

These parameters apply globally to the surface computed. They are maximum values. The actual values are computed automatically by the action.

Surfaces Network creates a NURBS surface, controlled by the tolerance (i.e. Tolerance), the number of segments and their order. Whenever possible, this surface consists of one 
single segment, otherwise, it is made of several segments. This surface may then be trimmed by the curves.

You can increase the order of the segments, thus reducing their number, or vice-versa. 

If the number of segments is x, this means that the surface computed will consist of a maximum of x segments, or less. The default number of segments is 64, the maximum number 
is 2048. 

If the order of segments is y, this means that each segment will have a maximum number of y control points in each direction, or less. The segment order may vary from 3 to 15.
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Advanced: Order and Segments in U and V

You may want to impose an order and a number of segments in both U and V direction. To do so, go to the Advanced tab. You can edit the fields to :

●     enter the number of segments in each direction,

●     enter the order of segments in each direction.

Click Apply to restart the computation.

●     Increasing the order of the segments may result in an oscillating surface, even if this is not visible.

Compute with ribbons:

This option is only available if a mesh is selected and is used when a tangent continuity is required between the wires.

The wires curves are projected on the mesh and a tangency ribbon is computed on the mesh around the curve projection, and then taken into account for the 
computation of the filling surface.

 
Use the Reset parameters button to reset the parameters

3.  Push the Apply button. The filling surface is computed. A progress bar is displayed. 
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4.  Go to the Results/Display tab.

Information on the points for the parameters taken into account by the computation are available in the box at the top of the tab (no dynamic display):
●     the maximum deviation found between the points of the cloud and the surface,

●     the mean deviation found between the points of the cloud and the surface. This deviation should be as small as possible.

●     the percentage of points of the cloud that are below the mean deviation.

●     Check the Spikes option to display the deviations.

●     Check the Segmentation option to display 

●     the segmentation on the surfaces computed,

●     the number of segments and order in U,

●     the number of segments and order in V.

●     Use the Deviation field  to enter the value above which the deviation spikes will be displayed. When you first enter the action, the 

Deviation value is the same as the Tolerance. Once a surface has been computed, the Deviation value is the computed one.
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By default, the options Display selection and Display constraints are checked. You can uncheck them according to your needs.

5.  Once you are satisfied, click OK to create the result: the surfaces are assemble (Tolerance = 0.1 mm) 

If the assembly does not respect the tolerance an error message is issued. 

If the assembly failed, an error message is issued and the surfaces are created separately.

A Surface.xx element is created in the specification tree.
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Transformations
This chapter deals with transformations in Quick Surface Reconstruction.

Symmetry
Translation
Rotation

Scale
Affinity

Axis to Axis
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Performing a Symmetry on Geometry 

 
This functionality is P2 for FreeStyle Shaper, Optimizer, and Profiler.

 
This task shows you how to transform geometry by means of a symmetry operation.

Open the Transform1.CATPart document.

 
1.  Click the Symmetry icon .

 

The Symmetry Definition dialog 
box appears as well as the Tools 
Palette.

2.  Select the Element to be transformed by symmetry.

3.  Select a point, line or plane as Reference element.

The figure below illustrates the resulting 

symmetry when the line is used as reference 

element.

The figure below illustrates the resulting 

symmetry when the point is used as reference element. 
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4.  Click OK to create the symmetrical element.

The element (identified as Symmetry.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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 Translating Geometry

 
This task shows you how to translate one, or more, point, line or surface element.

Open the Translate1.CATPart document.

 
1.  Click the Translate icon .

 The Translate Definition 
dialog box appears as well 
as the Tools Palette.

2.  Select the Element to be translated.

3.  Select the Vector Definition.

Direction, distance

1.  Select a line to 

take its orientation 

as the translation 

direction or a plane 

to take its normal 

as the translation 

direction.

You can 
also specify 
the 
direction by 
means of X, 
Y, Z vector 
components 
by using 
the 
contextual 
menu on 
the 
Direction 
field. 
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2.  Specify the 

translation 

Distance by 

entering a value or 

using the spinners.

Point to Point

1.  Select the Start 

point.

2.  Select the End 
point.

Coordinates

1.  Define the X, Y, 
and Z coordinates.
In the example 
besides, we chose 
50mm as X, 0mm 
as Y, and -100 as 
Z.

4.  Click OK to create the translated element.

The element (identified as Translate.xxx) is added to the specification tree.
The original element is unchanged.

  
●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to either Surface or 
Volume option. This switch only concerns volumes since the transformation of a surface can only be a surface. Thus in 
case of multi-selection of volumes and surfaces, the switch only affect volumes.
To have further information about volumes, please refer to the corresponding chapter.
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●     Use the Repeat object after OK 

checkbox to create several translated 
surfaces, each separated from the 
initial surface by a multiple of the 
Distance value.
Simply indicate in the Object 
Repetition dialog box the number of 
instances that should be created and 
click OK.

 
●     The elements to be translated are kept next time you enter the command and you change the vector definition.

●     You can select an axis system as the Element to be translated, providing it was previously created.

The element is identified as Translate.xxx in the specification tree, however the associated icon is the axis system's .

 Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.

The following capabilities are available: Stacking Commands, Selecting Using Multi-Output, Measure Between and Measure 
Item.
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 Rotating Geometry

 
This task shows you how to rotate geometry about an axis.

Open the Transform1.CATPart document.

 
1.  Click the Rotate icon .

 

 The Rotate Definition dialog box 
appears as well as the Tools Palette.

2.  Select the Element to be rotated.

3.  Select a line as the rotation Axis.

4.  Enter a value or use the drag manipulator to 

specify the rotation Angle.

5.  Click OK to create the rotated element.

The element (identified as Rotate.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.
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●     Use the Repeat object after OK checkbox to 
create several rotated surfaces, each separated 
from the initial surface by a multiple of the Angle 
value.
Simply indicate in the Object Repetition dialog 
box the number of instances that should be 
created and click OK.

 
●     You can select an axis system as the Element to be rotated, providing it was previously created.

The element is identified as Rotate.xxx in the specification tree, however the associated 

icon is the axis system's .

●     You can edit the rotated element's parameters. Refer to Editing Parameters to find out how to display 
these parameters in the 3D geometry.

The following capabilities are available: Stacking Commands,  Selecting Using Multi-Output, Measure 
Between and Measure Item.
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Transforming Geometry by Scaling 

 
This task shows you how to transform geometry by means of a scaling operation.

Open the Transform1.CATPart document.

 
1.  Click the Scaling icon .

 The Scaling Definition 
dialog box appears as well 
as the Tools Palette.

2.  Select the Element to be transformed by scaling.

3.  Select the scaling Reference point, plane or planar surface.

4.  Specify the scaling Ratio by entering a value or using the drag manipulator.

The figure below illustrates the resulting 
scaled element when the plane is used as 

reference element (ratio = 2).

The figure below illustrates the resulting scaled element when 
the point is used as reference element (ratio = 2).

5.  Click OK to create the scaled element.

The element (identified as Scaling.xxx) is added to the specification tree.
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●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.

●     Use the Repeat object after OK 
checkbox to create several scaled 
surfaces, each separated from the 
initial surface by a multiple of the 
initial  Ratio value.
Simply indicate in the Object 
Repetition dialog box the number of 
instances that should be created and 
click OK.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Transforming Geometry by Affinity

 
This task shows you how to transform geometry by means of an affinity operation.

Open the Transform1.CATPart document.

 
1.  Click the Affinity icon .

 

 The Affinity Definition dialog box appears as 
well as the Tools Palette.

2.  Select the Element to be transformed by affinity.

3.  Specify the characteristics of the Axis system to be used for the affinity operation:

●     the Origin (Point.1 in the figures below)

●     the XY plane (the XY plane in the figures below)

●     the X axis (Line.1 in the figures below).

4.  Specify the affinity Ratios by entering the desired X, Y, Z values.

The figure below illustrates the resulting affinity
with ratios X = 2, Y =1 and Z=1.
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The figure below illustrates the resulting affinity
with ratios X = 2, Y =1 and Z=2.

The figure below illustrates the resulting affinity
with ratios X = 2, Y =2.5 and Z=2
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5.  Click OK to create the affinity element.

The element (identified as Affinity.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Transforming Elements
From an Axis to Another

 

This task shows you how to transform geometry positioned according to a given axis system into a new 
axis system. The geometry is duplicated and positioned according to the new axis system. One or more 
elements can be transformed at a time, using the standard multi-selection capabilities.
See also Defining an Axis System.

Open the Transform2.CATPart document.

 
1.  Click the Axis To Axis icon .

 The Axis to Axis Definition dialog box 
appears as well as the Tools Palette.

2.  Select the Element to be transformed into a new 

axis system.
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3.  Select the initial (Reference) axis system, that is 

the current one.

4.  Select the Target axis system, that is the one into 

the element should be positioned.

5.  Click OK to create the transformed element.

New geometry is now positioned into the new axis system.

The element (identified as Axis to axis transformation.xxx) is added to the specification tree.
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●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.

The following capabilities are also available: Stacking Commands and Selecting Using Multi-Output.
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Segmentation
This chapter deals with segmentation in Quick Surface Reconstruction.

Segmentation by Curvature Criterion
Segmentation by Slope Criterion
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Segmentation by Curvature Criterion

 

This task will show you how to define areas on a polygon along the curvatures or curvature radii. 

There are five curvatures:

●     Maximum,

●     Minimum,

●     Mean,

●     Gaussian,

●     Absolute.

The geometric construction of the maximum and minimum curvatures is the following: let be a plane containing the normal to the 
surface in a given point. This plane cuts the surface along a curve that has a given curvature in this point. If this plane rotates around the 
normal, the curvatures of the curves intersecting the surface will vary between two utmost values. These two values are the maximum 
(KM) and the minimum (Km) curvatures.

The mean curvature is equal to (KM+Km)/2. The utmost values appear where the surface is the most warped. The mean curvature is 
largely used to detect irregularities on the surface. A minimal surface is characterized by a null mean curvature.

The gaussian curvature is equal to KM.Km. It describes the local shape of a surface in one point:

●     if it is positive, the point is elliptic, i.e. the surface has locally the shape of an ellipsoid around that point,

●     if it is negative, the surface is hyperbolic in this points, i.e. the local shape is a horse saddle,

●     it it is null, the surface is parabolic in this point, i.e. one of the maximum or minimum curvatures is null in this point. The cone and the 
cylinder are two surfaces where all points are parabolic.

The absolute curvature is equal to |KM|+|Km|. It is used to detect the surface areas where the surface is locally almost flat (the absolute 
curvature is almost null).

The curvature radii are the inverse of the corresponding curvatures. Only the maximum and the minimum radii are relevant.

 

It is carried out on polygons only.

Open the Curvature01.CATPart from the samples directory.

 
1.  Click the Segmentation by Curvature Criterion icon. The Curvature Analysis dialog box is displayed.

2.  Select the polygon to analyze.
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3.  Select the type of analysis from the combo box: Curvature or Radius. Sweep the polygon with the cursor: The value of the 

curvature or the radius is displayed dynamically as you move the cursor:

This is especially helpful to retrieve the value of fillets.
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4.  Click the polygon: scans are displayed: combine the types of analysis and the value in the top spinner box to display scans 

according to your needs:

5.  Use the Filter cursor to remove unwanted points.

 

6.  Click OK to create the result. You can choose to create: 

❍     Scans, either distinct or grouped:
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Scans.x elements are created in the specification tree. 

●     or Clouds, that is sub-polygons:

 

Sub Polygon.x elements are created in the specification tree. 

These polygons can then be processed with the Basic Surface Recognition action, for example. 

The input polygon is sent to the NoShow.
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Segmentation by Slope Criterion

 

This task shows you how to perform a slope analysis. 

This type of analysis identifies lines on the analyzed element where the deviation from the slope direction 
at any points corresponds to a specified value.

The Z axis gives the view direction. If the deviation angle=0, the lines are the zones of the analyzed 
element where the normal is orthogonal to the view direction (apparent contour). If the deviation angle is 
different from 0, the lines are the zones where the normal is orthogonal to the view direction increased by 
the angle.

 

Open the Slope1.CATPart from the samples directory.

 1.  Click the Segmentation by Slope Criterion icon  and select the polygon.

2.  The Segmentation by Slope Criterion dialog box is displayed. The compass is put on the 

polygon. By default, the angle is set to 0.
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3.  Use the Values/Angle field to set the angle of the deviation with the view direction.
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4.  Use the Compass/Angle field and the Compass push buttons to set the view direction. Or 

manipulate the compass as you wish.
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5.  Use the Filter spinner to reduce the number of points of the lines.

6.  If you sweep the cursor on the polygon, the deviation angle is displayed.

7.  Click OK to create the result. You can choose to create:

●     Scans, either distinct or grouped:
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Scans.x elements are created in the specification tree. 

●     or Clouds, that is sub-polygons:

 

  

Sub Polygon.x elements are created in the specification tree. 

These polygons can then be processed with the Basic Surface Recognition action, for 

example. 

166Page Quick Surface Reconstruction Version 5 Release 13



The input polygon is sent to the NoShow. 
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Analysis
This chapter deals with analyses in Quick Surface Reconstruction.

Information
Distance Analysis
Connect Checker

Curvature Analysis
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  Information

This task shows you how to get information on a cloud of points.

Open Info1.CATPart from the samples directory.

1.  Click the Information icon  and select a cloud of points.

2.  An information box is displayed, with the statistics about the selected cloud: 

❍     Bounding box ,and active bounding box,

❍     Number of points, of active points, of selected points, of filtered points,

❍     Total number of triangles and of active triangles.

3.  If you select another cloud, the information box is updated with the statistics of that cloud.

4.  Push the Close button when you are finished to exit the action.
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Analyzing Distances
Between Two Sets of Elements

This task shows how to analyze the distance between any two geometric elements, or between two sets of 
elements.

Open the DistanceAnalysis1.CATPart document.

1.  Select an element, or set of elements.

2.  Click the Distance Analysis icon  

in the Shape Analysis toolbar.

The Distance dialog box is displayed. 

3.  Click Second set and select a second element, or set.

The distance analysis is computed. 

Each color identifies all discretization points 
located at a distance between two values, as 
defined in the Color Scale dialog box. 
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●     When computing the distance between two curves, there is no negative values possible as opposed to 
when analyzing the distance between a surface and another element. Indeed, surfaces present an 
orientation in all three space directions whereas, in the case of planar curves for example, only two 
directions are defined. Therefore the distance is always expressed with a positive value when 
analyzing the distance between two curves. 

●     The element which dimension is the smallest (0 for points,1 for curves, 2 for surfaces for example) is 
automatically discretized, if needed.
When selecting a set of element, the system compares the greatest dimension of all elements in each 
set, and discretizes the one with the smallest dimension. 

●     Use the Invert Analysis button to invert the computation direction.

In some cases, when inverting the computation direction does not make sense, when one of the elements 
is a plane for example, the Invert Analysis button is grayed.

●     If you check the Running point option, 
you need to move the pointer over the 
discretized element to display more precise 
distance value between the point below the 
pointer and the other set of elements. 
The projection is visualized and the value is 
displayed in the geometry area.

Note that the analyzed point is not necessarily 
a discretized point in this case. This is obvious 
when a low discretization value is set, as 
shown here.
Two analysis modes are available, with corresponding color ramps, provided the Color scale checkbox is 
checked.
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a. Full (P2 only): activated by the Full color 

range  icon, it provides a complete 

analysis based on the chosen color range. This 
allows you to see exactly how the evolution of 
the distance is performed on the selected 
element.

   

b. Limited: activated by the 

Limited color range , it 

provides a simplified analysis, 
with only three values and four 
colors.

Whichever mode you choose the use of the color scale is identical: it lets you define colors in relation to 
distance values. 

You can define each of the values and color blocks, therefore attributing a color to all elements which 
distance falls  into to given values.

 
●     The Auto Min Max button enables to automatically update the minimum and maximum values (and 

consequently all values between) each time they are modified.
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●     You can right-click on a color in the color 
scale to display the contextual menu:

   

- Edit: it allows you to modify 
the values in the color range to 
highlight specific areas of the 
selected surface. The Color 
dialog box is displayed allowing 
the user to modify the color 
range. 

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of 
displayed colors in the color scale. In this case, the selected color is hidden, and the 
section of the analysis on which that color was applied takes on the neighboring color. 

●     You can also right-click on the value to 
display the contextual menu:

   
 - Edit: it allows you to modify 
the edition values. The Value 
Edition dialog box is displayed: 
enter a new value (negative 
values are allowed) to redefine 
the color scale, or use the slider 
to position the distance value 
within the allowed range, and 
click OK.
The value is then frozen, and 
displayed in a green rectangle.
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- Use Max/Use Min : it allows you to evenly distribute the color/value interpolation 
between the current limit values, on the top/bottom values respectively, rather than 
keeping it within default values that may not correspond to the scale of the geometry being 
analyzed. Therefore, these limit values are set at a given time, and when the geometry is 
modified after setting them, these limit values are not dynamically updated. 

For now only the linear interpolation is allowed, meaning that between two set (or frozen) 
colors/values, the distribution is done progressively and evenly.

The color scale settings (colors and values) are saved when exiting the command, meaning the same 
values will be set next time you edit a given distance analysis capability.
However, new settings are available with each new distance analysis.

5.  Set the distance analysis type (we checked the Auto Scale button and unchecked the Min/Max 

values button):

 Projection Space

 

 The Projection Space area helps you define the preprocessing of the input elements used for the 
computation. 

This frame is only available when analyzing 
distances between curves.

 

 

●     3D : elements are not modified and 

the computation is done between the initial 
elements.

 
●     Projection according to the X , Y , or Z  axis: the computation is done between the 

projection of selected elements.

 
●     Projection according to the compass current orientation : the computation is done between the 

projection of selected elements.
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●     Planar distance : the distance is 

computed between a curve and the 
intersection of the  plane containing that 
curve.

 Measurement Direction  

 

 The Measurement Direction area provides options to define how set the direction used for the distance 
computation.

●     Normal distance : the distance is 

computed according to the normal to the 
other set of elements.

 
●     Direction according to the X , Y , 

or Z  axis.

 

 
●     Direction according to the compass 

current orientation .

 

6.  Click the  icon to display the 2D diagram distance analysis window. The latter allows to 

visualize the distance evolution.
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 Drawing modes:

●     Vertical Inverse Scale  : to draw the curves in a linear horizontal scale and and inverse vertical 

scale.

●     Reframe  : to reframe the frame

7.  Click More>> in the Distance dialog 

box to see, and choose further display 

and discretization options:
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●     Color scale: to display the Color Scale dialog box whether the full or the limited color range.

 

●     Statistical distribution: to display the 
percentage of points between two values.

This option is only available if the Color Scale 

checkbox is checked.
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●     Min/Max values: to display the minimum 
and maximum distance values and 
locations on the geometry.

●     Points: to see the distance analysis in the 
shape of points only on the geometry (The 
Spikes button is unchecked)

 
●     Spikes: to see the distance analysis in the shape of spikes on the geometry.

You can further choose to: 
❍     set a ratio for the spike size

❍     choose an automatic optimized spike size (Auto scale)

❍     invert the spike visualization on the geometry

❍     display the envelope, that is the curve connecting all spikes together

   
●     Use the Texture option to check the 

analysis using color distribution.
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●     This option is only available with surfacic 
elements in at least one set, providing this 
set is discretized. 
The distance is computed from this 
discretized set to the other set. The texture 
mapping is computed on the discretized 
surface.
It is not advised to use it with planar 
surfaces or ruled surfaces.

●     Statistical distribution, Min/Max 
values, and Points cannot be visualized 
when using the Texture option.

●     The visualization mode should be set to 
Shading with Texture and Edges, and 
the discretization option should be set to a 
maximum (in CATIA Infrastructure User 
Guide, see Improving Performances, the 
3D Accuracy -> Fixed option should be 
set to 0.01).
Check the Materials  option in  the View -
> Render Style -> Customize View 
command to be able to see the analysis 
results on the selected element. Otherwise 
a warning is issued.

●     Use the Max Distance option to relimit the 
distance: for example, set the value to 
150mm. The maximum value is displayed 
accordingly on the geometry.

 
●     Use the Discretization option to reduce or increase the number of points of the second set of 

elements taken into account when computing the distance.

●     Automatic trap: to delimit the second set of points to be taken into account for the computation, in 
the case of a large cloud of points,  thus improving the performances.
Be careful when using the Automatic trap option with certain cloud configurations, such as spiralling 
clouds of points for example, as the automatic trap may remove too many points to generate 
consistent results.
In this case, it is best to deactivate the check button.
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8.  Click OK to exit the analysis while retaining it.

The analysis (identified as Distance Analysis.x) is added to the specification tree.

●     Even though you exit the analysis, the color scale is retained till you explicitly close is. This is like a 
shortcut allowing you to modify one of the analyzed elements, which leads to a dynamic update of the 
distance analysis, while viewing the set values/colors at all times and without having to edit the 
distance analysis.

●     When analyzing clouds of points, in normal projection type, the distances are computed as the normal 
projection of each point of the first cloud onto the triangle made by the three points closest to that 
projection onto the second cloud.
As it is a projection, using the Invert Analysis button does not necessarily gives symmetrical results.

●     When you select the geometrical set as an input in the specification tree, all the elements included in 
this geometrical set are automatically selected too. 

The auto detection capability is available from the FreeStyle Dashboard.

 

180Page Quick Surface Reconstruction Version 5 Release 13



Checking Connections Between Surfaces

This task shows how to analyze how two surfaces are connected, following a blend, match, or fill 
operation for example.
Three types of analyses are available.

❍     Distance: the values are expressed in millimeters

❍     Tangency: the values are expressed in degrees

❍     Curvature: the values are expressed in percentage.

Open the ConnectChecker1.CATPart document.

1.  Select both surfaces to be 

analyzed.

2.  Click the Connect Checker icon 

 in the Shape Analysis 

toolbar.

The Connect Checker 
dialog box is displayed 
as well as another dialog 
box showing the color 
scale and identifying the 
maximum and minimum 
values for the analysis 
type. 

The Auto Min Max 
button enables to 
automatically update the 
minimum and maximum 
values (and consequently 
all values between) each 
time they are modified.
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Check the Internal edges option if you want to analyze the internal connections.
By default, the check box is unchecked.

  

 

3.  Choose the analysis type to be performed: Distance, Tangency or Curvature.

4.  Set the Maximum gap above which no analysis will be performed. All elements apart from a 

greater value than specified in this field are considered as not being connected, therefore do not 

need to be analyzed.

Be careful not to set a Maximum gap greater than the size of the smallest surface present in the 

document.
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5.  Check the analysis results on 

the geometry.

Here we are analyzing 
the distance between the 
surfaces. Each color 
section indicates on the 
geometry the distance 
between the surfaces.

From the Connect Checker dialog box, you can choose a number of visualization and computation options: 
●     the comb: that is the spikes corresponding to the distance in each point

●     the envelope: that is the curve connecting all spikes together

●     Information: that is the minimum and maximum values

Finally, the scaling option lets you define the visualization of the comb. In automatic mode 
the comb size is zoom-independent and always visible on the screen, otherwise you can 
define a coefficient multiplying the comb exact value.

6.  Check the Information button:

Two texts are displayed 
on the geometry 
localizing the minimum 
and maximum values of 
the analysis as given in 
the Connect Checker 
dialog box.
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You can also choose the 
discretization, that is the 
numbers of spikes in the 
comb (check the Comb 
option to see the 
difference).
The number of spikes 
corresponds to the 
number of points used 
for the computation:

●     Light: 5 spikes are 
displayed.

This mode enables to 
obtain consistent results 
with the visualization of 
sharp edges.
An edge is considered as 
sharp if its tangency 
deviation is higher than 
0.5 degree. To only 
detect tangency 
deviations on sharp 
edges, specify a 
deviation of 0.5 degree 
minimum.

To visualize sharp edges, 
make sure the View -> 
Render Style -> 
Shading with Edges 
and Hidden Edges 
option is checked.

 
●     Coarse: 15 spikes 

are displayed

●     Medium: 30 spikes 
are displayed

●     Fine: 45 spikes are 
displayed

The Full result is only available with the Generative Shape Design 2 product. 

The number of selected elements and the number of detected connections are displayed below the color 
range.
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7.  Click the Quick... button to 

obtain a simplified analysis 

taking into account tolerances 

(either distance, tangency, or 

curvature).

The comb is no longer 
displayed.
The Connect Checker 
dialog box changes to 
this dialog box.

You can use the check 
button to switch from 
one analysis type to 
another.
The Maximum gap and 
information are retained 
from the full analysis.
The maximum deviation 
value is also displayed 
on the geometry.

You can check the Overlapping button to highlight  where, on the common boundary, the 
two surfaces overlap. In this case the other analysis types are deactivated.

In P1 mode, only the quick analysis is available.

8.  Use the spinners to define the 

deviation tolerances.

For example, the red 
area indicates all points 
that are distant of more 
than 0.1 mm.

The maximum deviation 
values on the current 
geometry are displayed 
to the right of the dialog 
box.
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9.  Click OK to create the analysis.

The analysis (identified as Surface Connection Analysis.x) is added to the specification tree 

(P2 only).

This allows the automatic update of the analysis when you modify any of the surfaces, 

using the control points for example.

If you do not wish to create the analysis, simply click Cancel.

●     You can edit the color range in both dialog boxes by double-clicking the color range manipulators 
(Connect Checker) or color areas (Quick Violation Analysis) to display the Color chooser.

●     If you wish to edit the Connection Analysis, simply double-click it from the specification tree.

●     If you no longer need the Connection Analysis, right-click Connection Analysis in the specification 
tree, and choose Delete.

●     The curvature difference is calculated with the following formula:

(|C2 -  C1|) / ((|C1 + C2|) / 2)

The result of this formula is between 0% et 200%.

●     You can analyze internal edges of a 
surfacic element, such as a Join for 
example, by selecting only one of 
the initial elements:

●     You can create an analysis on an entire geometrical set simply by selecting it in the specification tree.
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Performing a Curvature Analysis

This task shows how to analyze the curvature of curves, or surface boundaries.

Open the Analysis1.CATPart document.

When analyzing surface 
boundaries:  

●     if you select the surface, the 
analysis is performed on all its 
boundaries

●     if you select a specific 
boundary, the analysis is 
performed only on this 
boundary.

1.  Click the Porcupine 

Curvature Analysis icon 

.

2.  Select the curve.

Automatically the curvature comb 
is displayed on the selected curve:
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3.  Define the analysis 

parameters in the 

Curvature Analysis dialog 

box.

●     Use the Project on Plane 

checkbox  to analyze the 

projected curve in the selected 

plane referenced by the 

compass.

●     If you uncheck the Project On 

Plane option, the analysis is 

performed according to the 

curve orientation. This is the 

default option.

4.  Use the spinners to adjust the number of strikes and modify the density.

5.  You can also decide to 

halve the number of spikes 

in the comb clicking as 

many times as wished the 

/2 button.

This option is particularly useful 
when the geometry is too dense to 
be read but the resulting curve 
may not be smooth enough for 
your analysis needs.

You could just as well double the 
number of spikes using the X2 
button.
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6.  Similarly, click the /2 

button to fine-tune the 

amplitude (size) of the 

spikes, and re-compute the 

analysis curve accordingly.

 

7.  Click Curvilinear to switch 

from the Parametric 

discretization mode to the 

Curvilinear analysis. You 

will get something like this:

 
8.  Check the Automatic option optimizes the spikes length so that even when zooming in or out, the spikes are 

always visible.

 

9.  Check the Logarithm 

option to display the 

logarithmic values in the 

3D geometry.

Displaying these values does not 
modify the analysis.
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10.  Click Reverse, you will get 

something like this:

That is the analysis 
opposite to what 
was initially 
displayed. This is 
useful when from 
the current 
viewpoint, you do 
not know how the 
curve is oriented.

11.  Use the Particular 

checkbox to display at 

anytime the minimum and 

the maximum points. 

Inflection points are displayed only 
if the Project on Plane and 
Particular checkboxes are checked.

12.  The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in 

Curvature, if Radius option is selected.

 
●     You can right-click on any of 

the spikes and select Keep 
this Point to keep the current 
point at this location.
A Point.xxx appears in the 
specification tree. 
If you check the Particular 
option, you have more options: 

❍     Keep all inflection points

❍     Keep local minimum 

(corresponds to the 

absolute minimum under 
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the running point)

❍     Keep local maximum 
(corresponds to the 
absolute maximum under 
running point)

❍     Keep global minimum (in 
case there are two curves, 
the point will be found on 
one or other of the curves)

❍     Keep global maximum 
(in case there are two 
curves, the point will be 
found on one or other of 
the curves)

This option is only available in P2 mode in FreeStyle Shaper, Optimizer, and Profiler.

13.  Finally, click the  icon to display the curvature graph:

The curvature profile and amplitude of the analyzed curve is represented in this diagram.

When analyzing a surface or several curves, i.e. when there are several curvature analyses on elements that are not 
necessarily of the same size for example, you can use different options to view the analyses. 
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For example, when analyzing a 
surface, by default you obtain this 
diagram, where the curves color 
match the ones on the geometry. 

●     Same vertical length : all 

curves are displayed according 
to the same vertical length, 
regardless of the scale

●     Same origin : all curves 

are displayed according to a 
common origin point on the 
Amplitude scale
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●     Vertical logarithm scale : 

all curves are displayed 
according to a logarithm scale 
for the Amplitude, and a 
linear scale for the Curve 
parameter.

Depending on the chosen option, values displayed in the diagram are updated.

The last icon  is used to reframe the diagram within the window, as you may move and zoom it within the window.

14.  Right-click a curve and 

choose one of the following 

options from the contextual 

menu:

●     Remove: removes the curve

●     Drop marker: adds Points.xxx 

in the specification tree

●     Change color: displays the 

Color selector dialog box that 

enables you to change the 
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color of the curve.

15.  Slide the pointer over the diagram to display the amplitude at a given point of the curve.

You can slide the pointer over the diagram and the 3D analysis.

Click the x in the top right corner to close the diagram.

16.  Click OK in the Curvature Analysis dialog box once you are satisfied with the performed analysis.

The analysis (identified as Curvature Analysis.x) is added to the specification tree.

In case of clipping, you may want to temporarily modify the Depth Effects' Far and Near Limits. See Setting Depth 

Effects in CATIA Infrastructure User Guide.
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WireFrame
 

Creating Points
Creating Lines
Creating Planes
Creating Circle
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Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle center

●     tangent point on a curve

●     between

 
Open the Points3D-1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

Coordinates 
●     Enter the X, Y, Z coordinates in the 

current axis-system.

●     Optionally, select a reference point.

The corresponding point is 
displayed.

 

 

When creating a point within a user-defined axis-system, note that the Coordinates in absolute axis-
system check button is added to the dialog box, allowing you to be define, or simply find out, the point's 
coordinates within the document's default axis-system.
If you create a point using the coordinates method and an axis system is already defined and set as 
current, the point's coordinates are defined according to current the axis system. As a consequence, the 
point's coordinates are not displayed in the specification tree.

The axis system must be different from the 
absolute axis.  
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On curve 
●     Select a curve

●     Optionally, select a reference point.

If this point is not on the 
curve, it is projected onto the 
curve.
If no point is selected, the 
curve's extremity is used as 
reference.

 

●     Select an option point to determine 
whether the new point is to be created: 

❍     at a given distance along the curve 
from the reference point

❍     a given ratio between the reference 
point and the curve's extremity.

      
●     Enter the distance or ratio value.

If a distance is specified, it can be: 
❍     a geodesic distance: the distance is 

measured along the curve

❍     an Euclidean distance: the distance is 
measured in relation to the reference 
point (absolute value).

The corresponding point is displayed.

If the reference point is located at the curve's extremity, even if a ratio value is defined, the created point 
is always located at the end point of the curve.
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You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the curve.

●     click the Middle Point button to display the mid-point of the curve.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, using the 
currently created point as the reference, as described in Creating Multiple Points in the Wireframe and 
Surface User's Guide. 

You will also be able to create 
planes normal to the curve at 
these points, by checking the 
Create normal planes also 
button, and to create all 
instances in a new 
geometrical set  by checking 
the Create in a new 
geometrical set button.
If the button is not checked 
the instances are created in 
the current geometrical set .

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference point is the 
projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be used as a 
reference point, or it creates an extremum point, and highlights it (you can then select another one if 
you wish) or the system prompts you to manually select a reference point.

 

Extremum points created on a closed curve 
are now aggregated under their parent 
command and put in no show in the 
specification tree.
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On plane 
●     Select a plane.

●     Optionally, select a point to define a 
reference for computing coordinates in 
the plane.

If no point is selected, the 
projection of the model's 
origin on the plane is taken as 
reference. 

 

 

 
●     Optionally, select a surface on which the 

point is projected normally to the plane.

If no surface is selected, the 
behavior is the same.

Furthermore, the reference 
direction (H and V vectors) is 
computed as follows: 
With N the normal to the 
selected plane (reference 
plane), H results from the 
vectorial product of Z and N 
(H = Z^N). 
If the norm of H is strictly 
positive then V results from 
the vectorial product of N and 
H (V = N^H).
Otherwise, V = N^X and H = 
V^N.

Would the plane move, during 
an update for example, the 
reference direction would 
then be projected on the 
plane. 

●     Click in the plane to display a point.
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On surface 
●     Select the surface where the point is to 

be created.

 

●     Optionally, select a reference point. By 
default, the surface's middle point is 
taken as reference. 

●     You can select an element to take its 
orientation as reference direction or a 
plane to take its normal as reference 
direction.
You can also use the contextual menu to 
specify the X, Y, Z components of the 
reference direction.

●     Enter a distance along the reference 
direction to display a point.

 
      

Circle center 
●     Select a circle, circular arc, or ellipse.

A point is displayed at the 
center of the selected 
element. 

      

200Page Quick Surface Reconstruction Version 5 Release 13



Tangent on curve 
●     Select a planar curve and a direction line.

A point is displayed at each 
tangent. 

      
The Multi-Result Management 
dialog box is displayed 
because several points are 
generated. 

●     Click YES: you can then select a 
reference element, to which only the 
closest point is created.

●     Click NO: all the points are created.

Between
●     Select any two points.

●     Enter the ratio, that is the percentage of 
the distance from the first selected point, 
at which the new point is to be.
You can also click Middle Point button 
to create a point at the exact midpoint 
(ratio = 0.5).

     

●     Use the Reverse direction button to 
measure the ratio from the second 
selected point.
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If the ratio value is greater than 1, the point is located on the virtual line beyond the selected points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.
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Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 It also shows you how to automatically reselect the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box appears.

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element selection.

Point - Point 

 
This command is only available with the Generative 
Shape Design 2 product.

●     Select two points.
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A line is displayed between the two 
points.
Proposed Start and End points of 
the new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, i.e. going 
from one point to the other according to the 
shortest distance along the surface geometry 
(blue line in the illustration below).
If no surface is selected, the line is created 
between the two points based on the shortest 
distance.

If you select two points on closed surface (a 
cylinder for example), the result may be unstable. 
Therefore, it is advised to split the surface and only 
keep the part on which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.
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●     Specify the Start and End points of the new line, that is the line endpoint location in relation to the 

points initially selected. These Start and End points are necessarily beyond the selected points, 
meaning the line cannot be shorter than the distance between the initial points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start and 
End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

Point - Direction 
 

●     Select a reference Point and a Direction line.
A vector parallel to the direction line is displayed 
at the reference point. 
Proposed Start and End points of the new line 
are shown.
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●     Specify the Start and End points of the new 
line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

  

Angle or Normal to curve
 

●     Select a reference Curve and a Support surface 
containing that curve.
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- If the selected curve is planar, then 
the Support is set to Default 
(Plane).

- If an explicit Support has been 
defined, a contextual menu is 
available to clear the selection.

 
●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given angle 
with respect to the tangent to the 
reference curve at the selected point. 
These elements are displayed in the 
plane tangent to the surface at the 
selected point. 
You can click on the Normal to 
Curve button to specify an angle of 
90 degrees. 
Proposed Start and End points of 
the line are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.
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●     Click the Repeat object after OK if you wish to 
create more lines with the same definition as the 
currently created line. 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of 
instances to be created before pressing OK.

As many lines as indicated in the dialog box are 
created, each separated from the initial line by a 
multiple of the angle value.

 

You can select the Geometry on Support check box if you want to create a geodesic line onto a support 

surface. 

The figure below illustrates this case.

 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how to display 
these parameters in the 3D geometry.
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Tangent to curve
 

●     Select a reference Curve and a point or 
another Curve to define the tangency. 

❍     if a point is selected (mono-tangent mode): 
a vector tangent to the curve is displayed at 
the selected point.

❍     If a second curve is selected (or a point in bi-
tangent mode), you need to select a support 
plane. The line will be tangent to both 
curves.

 - If the selected curve is a line, then 
the Support is set to Default 
(Plane).

- If an explicit Support has been 
defined, a contextual menu is 
available to clear the selection.

 When several solutions are possible, 
you can choose one (displayed in 
red) directly in the geometry, or 
using the Next Solution button.

     

 

 

Line tangent to curve at a given point Line tangent to two curves
●     Specify Start and End points to define the new line.

The corresponding line is displayed.
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Normal to surface 
 

●     Select a reference Surface and a Point.
A vector normal to the surface is displayed at 
the reference point. 
Proposed Start and End points of the new line 
are shown.

●     Specify Start and End points to define the new 
line.
The corresponding line is displayed.
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Bisecting 
 

●     Select two lines. Their bisecting line is the line 
splitting in two equals parts the angle between 
these two lines. 

●     Select a point as the starting point for the line. 
By default it is the intersection of the bisecting 
line and the first selected line.
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●     Select the support surface onto which the 
bisecting line is to be projected, if needed.

●     Specify the line's length in relation to its starting 
point (Start and End values for each side of the 
line in relation to the default end points).
The corresponding bisecting line, is displayed.

●     You can choose between two solutions, using 
the Next Solution button, or directly clicking 
the numbered arrows in the geometry.

3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

  
●     Regardless of the line type, Start and End values are specified by entering distance values or by 

using the graphic manipulators.

●     Start and End values should not be the same.

  
 

●     Select the Length Type: 
❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be greyed out when one of the Infinite options is chosen.

     
●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start 

point.

●     In most cases, you can select a support on which the line is to be created. In this case, the selected 
point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting the 
Reverse Direction button (not available with the point-point line type).

     

Automatic Reselection
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This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 

The Reselect Second Point at next 
start option appears in the Line 
dialog box.

3.  Check it to be able to later 

reuse the second point.

4.  Create the second point.

5.  Click OK to create the first 

line.

  
 The Line dialog box opens again with 

the first point initialized with the 
second point of the first line.

6.  Click OK to create the second point.

7.  Click OK to create the second line, and so 

on.

 

 To stop the repeat action, simply uncheck the option or click Cancel in the Line dialog box.
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CreatingPlanes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a line

●     through a planar 
curve

●     normal to a curve

●     tangent to a surface

●     from its equation

●     mean through points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can move using the 
graphic manipulator.

Offset from plane

●     Select a reference Plane then enter an 
Offset value.

A plane is displayed offset from the 
reference plane.
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Use the Reverse Direction button to  
reverse the change the offset direction, or 
simply click on the arrow in the geometry.

      
●     Click the Repeat object after OK if you wish to create 

more offset planes . 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of instances to be 
created before pressing OK.

As many planes as indicated in the dialog 
box are created (including the one you were 
currently creating), each separated from the 
initial plane by a multiple of the Offset 
value. 

 

Parallel through point 

●     Select a reference Plane and a Point.
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A plane is displayed parallel to the reference 
plane and passing through the selected 
point.

Angle or normal to plane 

●     Select a reference Plane and a Rotation 
axis.
This axis can be any line or an implicit 
element, such as a cylinder axis for 
example. To select the latter press and 
hold the Shift key while moving the 
pointer over the element, then click it.

●     Enter an Angle value.
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A plane is displayed passing through the 
rotation axis. It is oriented at the specified 
angle to the reference plane. 

●     Click the Repeat object after OK if you wish to create more planes at an angle from the initial 
plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances 
to be created before pressing OK.

As many planes as indicated in the dialog 
box are created (including the one you were 
currently creating), each separated from the 
initial plane by a multiple of the Angle 
value.

Here we created five planes at an angle of 
20 degrees.

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out how to 
display these parameters in the 3D geometry.

Through three points 

●     Select three points.
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The plane passing through the three points 
is displayed. You can move it simply by 
dragging it to the desired location.

Through two lines 

●     Select two lines.

The plane passing through the two line 
directions is displayed.
When these two lines are not coplanar, the 
vector of the second line is moved to the 
first line location to define the plane's 
second direction. 
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Check the Forbid non coplanar lines button to specify that both lines be in the same plane.

Through point and line 

●     Select a Point and a Line.

The plane passing through the point and the 
line is displayed. 
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Through planar curve 

●     Select a planar Curve.

The plane containing the curve is displayed.

Tangent to surface 

●     Select a reference Surface and a Point.
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A plane is displayed tangent to the surface 
at the specified point.

Normal to curve 

●     Select a reference Curve.

●     You can select a Point. By default, the 
curve's middle point is selecte.
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A plane is displayed normal to the curve at 
the specified point. 

Mean through points 

●     Select three or more points to display 
the mean plane through these points.

It is possible to edit the plane by first 
selecting a point in the dialog box list then 
choosing an option to either:

●     Remove the selected point

●     Replace the selected point by another 
point.
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Equation 

●     Enter the A, B, C, D components of the 
Ax + By + Cz = D plane equation.

 

Select a point to position the plane through 
this point, you are able to modify A, B, and 
C components, the D component becomes 
grayed.

 

Use the Normal to compass button to 
position the plane perpendicular to the 
compass direction.

Use the Parallel to screen button to 
parallel to the screen current view.

223Page Quick Surface Reconstruction Version 5 Release 13



3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
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Creating Circles

 

This task shows the various methods for creating circles and circular arcs: 

●     center and radius

●     center and point

●     two points and radius

●     three points

●     bitangent and radius

●     bitangent and point

●     tritangent

●     center and tangent

 

Open the Circles1.CATPart document.
Please note that you need to put the desired geometrical set in show to be able to perform the corresponding scenario. 

 
1.  Click the Circle icon .

The Circle Definition dialog box appears. 

2.  Use the combo to choose the desired circle type.

Center and radius 
 

●     Select a point as circle Center.

●     Select the Support plane or surface where the circle 
is to be created.

●     Enter a Radius value.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.
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If a support surface is selected, the circle lies on the plane tangent to the surface at the selected point.

Start and End angles can be specified by entering values or by using the graphic manipulators.
     

Center and point 
 

●     Select a point as Circle center.

●     Select a Point where the circle is to be created.

●     Select the Support plane or surface where the circle 
is to be created.

The circle, which center is the first selected point and 
passing through the second point or the projection of 
this second point on the plane tangent to the surface at 
the first point, is previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

      

Two points and radius 
 

●     Select two points on a surface or in the same plane.

●     Select the Support plane or surface.

●     Enter a Radius value.

The circle, passing through the first selected point and 
the second point or the projection of this second point 
on the plane tangent to the surface at the first point, is 
previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two selected points as end 
points. 

You can use the Second Solution button, to display 
the alternative arc.
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You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

     

Three points 
 

●     Select three points where the circle is to be created.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two of the selected points 
as end points.

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.
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Bi-tangent and radius 
 

●     Select two Elements (point or curve) to which the 
circle is to be tangent.

●     Select a Support surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 
●     Enter a Radius value.

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points. 

 

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with Element 1 trimmed.

These options are only available with the Trimmed 
Circle limitation.
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Bi-tangent and point 
 

●     Select a point or a curve to which the circle is to be 
tangent.

●     Select a Curve and a Point on this curve.

●     Select a Support plane or planar surface.

The point will be projected onto the curve.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 

Complete circle
For a circular arc, you can choose the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle Complementary trimmed circle

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with both elements trimmed.
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These options are only available with the Trimmed 
Circle limitation.

     

Tritangent 
 

●     Select three Elements to which the circle is to be 
tangent.

●     Select a Support planar surface.

 If one of the selected inputs is a planar curve, then the 
Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual 
menu is available to clear the selection in order to select 
the desired support.

This automatic support definition saves you from 
performing useless selections.

 
●     Several solutions may be possible, so select the arc 

of circle that you wish to create.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. The first 
and third elements define where the relimitation ends. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two tangent points as end 
points.

  

You can select the Trim Element 1 and Trim Element 
3 check boxes to trim the first element or the third 
element, or both elements.
Here is an example with Element 3 trimmed.

These options are only available with the Trimmed 
Circle limitation.

     
 Center and tangent

 

There are two ways to create a center and tangent 
circle:
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1.  Center curve and radius

●     Select a curve as the Center Element.

●     Select a Tangent Curve.

●     Enter a Radius value.

  

 2.  Line tangent to curve definition

●     Select a point as the Center Element.

●     Select a Tangent Curve.

 

 

●     If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

●     The circle center will be located either on the center curve or point and will be tangent to tangent curve.

●     Please note that only full circles can be created.
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4.  Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
When several solutions are possible, click the Next Solution button to move to another arc of circle, or directly select the arc you 
want in the 3D geometry.

A circle may have several points as center if the selected element is made of various circle arcs with different centers.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.
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Interoperability
Quick Surface Reconstruction complies with the following CATIA V5 standards:

Points in Generative Shape Design
Updating Your Design

Using the Historical Graph
Creating Datums
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Interoperability

This task shows you how to use points from a cloud of points in Generative Shape Design.

Open the Interoperability.CATPart from the samples directory. We used the Line Definition for our 
example, but the operating mode is the same for all creation action requiring points.

1.  Select the type of creation from the combo list of the dialog box. 

2.  Go to the next Point field and choose Create Point from the contextual menu. 

3.  The Point Definition dialog box is displayed. 
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4.  Click a point on the cloud. Its coordinates are displayed in the Point Definition dialog box. Click 

OK to confirm the creation of this point.

5.  In the main dialog box, go to the next Point field and repeat the above steps as many times as 

necessary.

6.  If necessary, push the Point icon on the right of the Point field to modify the point you have 

created: the Point Definition dialog box is displayed and updated according to your pick on the 

cloud.
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Updating Your Design

 

This task explains how and when you should update your design.

The point of updating your design is to make the application take your last operation into account. 
Indeed some changes to geometry or a constraint may require rebuilding the part. To warn you that an 
update is needed, CATIA displays the update symbol next to the part name and displays the 
corresponding geometry in bright red.

To update a part, the application provides two update modes: 

●     automatic update, available in Tools -> Options -> Mechanical Design -> Assembly Design -

> General tab. If checked, this option lets the application update the part when needed.

●     manual update, available in Tools -> Options -> Mechanical Design -> Assembly Design -> 

General tab, it lets you control the updates of your part. You simply need to click the Update icon 

 whenever you wish to integrate modifications. 

 
Non-updated wireframe and surface elements are displayed in red.

 
1.  To update the part, click the Update icon .

A progression bar indicates the evolution of the operation. 

 

You can cancel the undergoing update by clicking the Cancel button available in the Updating... dialog 
box.

●     Keep in mind that some operations such as confirming the creation of features (clicking OK) do not 
require you to use the update command. By default, the application automatically updates the 
operation.
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●     The Update capability is also available via Edit -> Update and the Update contextual command. 

●     To update the feature of your choice, just select that feature and use the Local  Update contextual 

command.

●     Besides the update modes, you can also choose to visualize the update on the geometry as it is 
happening by checking the Activate Local Visualization option from the Tools -> Options -> 
Infrastructure -> Part Infrastructure, General tab.

In this case, as soon as you have clicked the Update icon :

1.  the geometry disappears from the screen
2.  each element is displayed as it is updated, including elements in No Show mode. 

Once they have been updated, they remain in No Show mode.

Interrupting Updates

 

This task explains how to update a part and interrupt the update operation on a given feature by means 
of a useful message you previously defined.

 
Open any document containing geometric elements.

 
1.  Right-click an element from the specification tree and choose the Properties contextual menu 

item.

The Properties dialog box is displayed. 

2.  From the Mechanical tab, check the Associate stop update option.
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3.  Enter the text to be displayed when the updating process will stop when reaching this element.

4.  Click OK to confirm and close the dialog box.

The Stop Update.1 feature is displayed in the specification 
tree, below the element for which it was defined.

5.  Whenever it is needed, click the Update icon  to update the whole part.

The updating process stops after having updated the element selected above, and issues 

the message as has been defined earlier:

6.  Click Yes or No, depending on what you intend to do with the geometry created based on the 

selected element.

 

Would you no longer need this capability, you can: 
●     right-click the element for which the stop was defined, choose the Properties contextual command 

and check the Deactivate stop update option from the Mechanical tab: the update will no longer at 
this element.

You notice that when the capability is deactivated, the Stop Update icon changes to:  in the 

specification tree.

●     right-click Stop Update.1 from the specification tree, and choose the Delete contextual command.
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Using the Historical Graph

 
This command is only available with the Generative Shape Design 2 product.

 
This task shows how to use the Historical Graph.

 
1.  Select the element for 

which you want to 

display the historical 

graph.

2.  Click the Show 

Historical Graph icon 

.

The Historical 
Graph dialog box 
appears. 

The following icon commands are available. 
●     Add graph

●     Remove graph

●     Reframe graph

●     Surface or Part graph representation

●     Parameters filter

●     Constraints filter.

3.  Just close the dialog box to exit this mode.
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Creating Datums

 

This task shows how to create geometry with the History mode deactivated.
 In this case, when you create an element, there are no links to the other entities that were used to 
create that element.

1.  Click the Create Datum icon  to deactivate the History mode.

It will remain deactivated until you click on the icon again. 

If you double-click this icon, the Datum mode is permanent. You only have to click again 
the icon to deactivate the mode. 

A click on the icon activates the Datum mode for the current or the next command. 

 
The History mode (active or inactive) will remain fixed from one session to another: it is in fact a setting.

 

 

240Page Quick Surface Reconstruction Version 5 Release 13



Display Options and Graphic Properties

This  task shows how to change the display option of clouds of points.

Open the Visu1.CATPart model the from the samples directory. It consists of four clouds of points: 

●     a mesh,

●     a cloud of points,

●     a set of scans,

●     a set of grids.

Their default colors are respectively: 
●     orange,

●     green,

●     cyan,

●     cyan.

The display options are available from the Cloud Display Options box. Further graphic properties are 
available from the Edit/Properties menu, in the Graphic tab. 

From the Cloud Display Options box, you can:

●     Choose the sampling of clouds of points (N of 100 points are displayed). 

●     Choose to display scans or grids as polylines, points, or both. 

●     Choose to display triangles, free edges, non-manifold edges of meshes. You can also choose their 
display mode: flat or smooth. 

From the Edit/Properties menu, you can:

●     Choose the fill color of the mesh and its transparency level,

●     Choose the color and symbol of the points of a cloud,

●     Choose the color, type and thickness of scans and grids,

●     Choose to elements pickable or not.

Cloud Display Options box 

The images below are only examples.

1.  Click the Cloud Display  icon  at the bottom of the screen. The Cloud Display Option 

dialog box is displayed.
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2.  Select the cloud to modify. Display options are proposed according to the type of the cloud 

selected:

 

Following options are not yet available: 

●     Protected,

●     Orientation,

●     Shrink,

●     Normal.

3.  For the cloud of points, you can choose to display only a percentage of the points making the 

cloud, using the Sampling option. By default, 100% of the points are displayed. You can change 

this value with the associated spinner.
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Sampling=100 Sampling=25

The Symbol options are not available in that box, but in the Graphic Properties menu.

For the sets of scans or grids, you can display them as line of points or points or both: 

For the mesh, you can: 
●     display the triangles, 
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●     visualize only the vertices for a lighter display (do not forget to de-activate the Smooth, Flat or 
Triangles options)

 instead of 
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●     the free edges in yellow, 

●     the non-manifold facets and their vertices in bold white lines. 

●     If you choose the display of triangles, the triangles accepting a non-manifold edge have their edges 
displayed as regular white lines. 
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●     display the  mesh as a smooth or a flat mesh.

 or 

 

The free edges displayed are those of the complete cloud of points: 
●     if you activate only a portion of a cloud of points, the free edges of that portion are not displayed.
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●     if you remove a portion of a cloud of points, the free edges of the remaining portion are displayed.

●     If you move a cloud of points or a mesh, its graphic display options (not the graphic properties) are 
lost.

●     The display options are not saved in the CATPart while the graphic properties are.

Edit/Properties menu (Graphic tab) 

For more information about this menu, please refer to the Displaying and Editing Graphic Properties  
chapter in the CATIA Infrastructure user's guide.

The images below are only examples.
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You can access this menu through Edit/Properties, or through the pop-up menu of the element, or 
display the Graphic Properties toolbar (View/Toolbars/Graphic Properties). 

 

or
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●     The color displayed in the Graphic Properties toolbar applies to meshes only.

●     The graphic properties are saved in the CATPart.

●     Use Fill/Color and Transparency to modify the color and transparency of meshs:

 

 

Please note that : 
●     the color of mesh free edges is yellow, and is not editable,

●     the color of non-manifold edges is white, and is not editable,

●     the default color of scans has changed to cyan.

For a higher transparency quality, go to Tools/Options/Display/Performances and check the High 
(Alpha blending) option.
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●     Use Edges/Color, Line type and Thickness to modify the display of scans and grids or of the 
triangles of a mesh :

●     Use Points/Color and Symbol to modify the display of clouds of points:

 

●     Use the Pickable check box to make an element pickable or not, and choose the pick option in the 
list below.
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Managing Geometrical Sets  

 

This task shows how to manage geometrical sets within the specification tree. This involves: 

●     inserting a geometrical set

●     removing a geometrical set

●     changing body

●     sorting the contents of a geometrical set

●     reordering components

You will find other useful information in the Managing Groups and Hiding/Showing chapters.
  

A geometrical set enables to reorganize the specification tree when it becomes too complex or too long. 
You can put any element you wish in the geometrical set, it does not have to be structured in a logical 
way.

  

●     You can insert and manipulate geometrical sets in the specification tree in much the same way as you 
manage files in folders.

●     These management functions have no impact on the part geometry.

●     You should refer to the Copying and Pasting section for information about how geometrical sets can be 
used in a part edition context.

●     When loading the Generative Shape Design workbench, a Geometrical Set automatically becomes the 
current body. 
This also means that only the results of the Hybrid Body, i.e. the result of all the operations performed 
on geometry, is visible and not any intermediate state of the Hybrid Body.

●     You can define the Generative Shape Design feature that is to be seen when working with another 
application, such as Generative Structural Analysis for example. 

To do this, while in the Generative Shape 
Design workbench: 

1.  Choose the Tools -> External 
View... menu item
The External View dialog box is 
displayed.

2.  Select the element belonging to a 
Geometrical Set that should always 
been seen as the current element 
when working with an external 
application.

3.  Click OK in the dialog box.
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The selected element will be the visible element in other applications, even if other 
elements are created later in the .CATPart document, chronologically speaking.

To check whether an external view element has already been specified, choose the Tools -
> External View... menu item again. The dialog box will display the name of the currently 
selected element. This also allows you to change elements through the selection of another 
element. Note that you cannot deselect an external view element and that only one 
element can be selected at the same time.

Open any .CATPart document containing Geometrical Sets.
You can also open the GeometricalSets2.CATPart document.

  

Inserting a Geometrical Set

1.  In the specification tree, select an element as the location of the new geometrical set. 

This element will be considered as a child of the new geometrical set and can be a geometrical set 

or a feature.

2.  Select the Insert -> Geometrical Set menu 

command.

The Insert Geometrical Set dialog box is 

displayed.

The Features list displays the elements to be 

contained in the new geometrical set.

3.  Enter the name of the new geometrical set.

4.  Use the Father drop-down list to choose the body 
where the new geometrical set is to be inserted. 
All destinations present in the document are listed 
allowing you to select one to be the father without 
scanning the specification tree. They can be:

❍     bodies

❍     geometrical sets

❍     ordered geometrical sets

❍     parts

5.  Select additional entities that are to be included in 

the new geometrical set.

252Page Quick Surface Reconstruction Version 5 Release 13



If all selected entities belong to the same geometrical set, 
the father of the new geometrical set is automatically set 
to the father of these entities.

 
6.  Click OK to create the geometrical set at the 

desired location.

The result is immediate. CATIA displays 

this new Geometrical Set.x, incrementing 

its name in relation to the pre-existing 

bodies, in the specification tree. It is 

created after the last current geometrical 

set and is underlined, indicating that it is 

the active geometrical set. The next 

created element is created within this 

geometrical set.

●     You cannot create a geometrical set within an ordered geometrical set and vice versa.

●     This Insert Geometrical Set dialog box is only available with the Generative Shape Design 2 product.

You can check the Create a Geometrical Set when creating a new part option in Tools -> Options -

> Infrastructure -> Part Infrastructure -> Part Document tab if you wish to create a geometrical 

set as soon as you create a new part. For more information about this option, please refer to the 

Customizing section of the Part Design User's Guide.

Removing a Geometrical Set
Two methods are available:

●     If you want to delete the geometrical set and all its contents:

1.  Right-click the geometrical set then select the Delete contextual command.

 
●     If you want to delete the geometrical set but keep its contents:

This is only possible when the father location of the geometrical set is another geometrical set. This is 
not possible when the father location is a root geometrical set.
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1.  Right-click the desired geometrical set then select the Geometrical Set.x object -> Remove 

Geometrical Set contextual command.

The geometrical set is removed and its constituent entities are included in the father 
geometrical set.

You cannot delete a feature within a geometrical set created on the fly. Indeed this geometrical set is 
considered as private and can only be deleted globally.

Moving a Geometrical Set to a New Body

 
1.  From the specification tree, select the element 

then choose the Geometrical Set.object -> 

Change Geometrical Set...  item from the 

contextual menu.

Multi-selection of elements of different types is supported. However, note that in this case, the contextual 
menu is not available, and that you can access this capability using the Edit menu item.

The Change Body dialog box is displayed.

The list of destinations is alphabetically 
sorted.
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2.  Select the Destination body where the geometrical set is to be located.

Here we selected Geometrical_Set.3.

You can do so by selecting the Body in the specification tree, or using the drop-down list 

from the dialog box.

By default, if you select a body, the geometrical set is positioned last within the new body. 

However, you can select any element in the new body, before which the moved 

geometrical set will be located.

3.  Select the element above which the one you 

already selected is to be inserted.

You can directly select this positioning element. In this case the Destination field of the Change Body 
dialog box is automatically updated with the Body to which this second element belongs.

4.  Click OK to move the geometrical set to the new 

body.

The element selected first is moved to its 

new location in the specification tree, but 

geometry remains unchanged. 
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●     Check the Change body unshared parents option 
to move all parents of the first selected element to its 
new location, provided these parents are not shared 
by any other element of the initial body.
In this case, all the unshared parents are highlighted 
prior to the move.

●     Check the Change body all parents option to move 
all parents of the first selected element to its new 
location, regardless of whether these parents are 
used (shared) by any other element of the initial 
body.
In this case, all the parent elements are highlighted 
prior to the move.

   

●     You can move a whole branch, i.e. a whole body and 
its contents, at a time.
Here we moved Geometrical_Set.3 last in 
Geometrical_Set.1.
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Sorting the Contents of a Geometrical Set
You may need to sort the contents of a Geometrical Set, when the geometric elements no longer appear 
in the logical creation order. In that case, use the Auto-sort capability to reorder the Geometrical Set 
contents in the specification tree (geometry itself is not affected). 
The Geometrical_Set.1 contains two extruded surfaces 
based on point-point lines. The specification tree looks 
like this:

   

1.  Right-click the Geometrical_Set.1 from the 

specification and choose the Geometrical_Set.1 

object -> AutoSort command.

Instantly, the contents of the Geometrical 

Set are reorganized to show the logical 

creation process.

The geometry remains unchanged.
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Reordering Components within a Geometrical Set
 This capability enables you to reorder elements inside the same geometrical set.

1.  Right-click the Geometrical_Set.1 from the 

specification tree and choose the Ordered 

Geometrical Set.1 object -> Reorder Children 

command.

The Reorder Children dialog box is displayed.

2.  Select an element.

3.  Use the arrows to move an element up or down.

 

Reordering Features 
 The Reorder command allows you to move a feature in a Geometrical Set. These features can be:

●     solids

●     shape features

●     sketches

For further information, please refer to the Reordering Features chapter in the Part Design User's Guide.
 

Replacing Features
 This capability is only available on shape features.

Please refer to the Replacing or Moving Elements chapter in the Part Design User's Guide.
 To manage this capability, the Do replace only for elements situated after the In Work Object 

option is available in Tools -> Options -> Part Infrastructure ->  General tab. It allows you to make 
the Replace option possible only for features located below the feature in Work Object and in the same 
branch.
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Operations
This chapter deals with operations in Quick Surface Reconstruction.

Joining Surfaces or Curves
Splitting Geometry
Trimming Geometry

Extrapolating Surfaces
Curves Slice
Adjust Nodes

CleanContour Split
Edge Fillet
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Joining Surfaces or Curves

 
This task shows how to join surfaces or curves.

 
Open the Join1.CATPart document.

 
1.  Click the Join  icon.

The Join Definition dialog 
box appears. 

 

In Part Design workbench, the Join 
capability is available as a contextual 
command named 'Create Join' that you 
can access from Sketch-based features 
dialog boxes.

2.  Select the surfaces or curves to be 

joined.

3.  You can edit the list of elements to be joined:
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●     by selecting elements in the geometry: 
❍     Standard selection (no button clicked):

when you click an unlisted element, it is added to the list 
when you click a listed element, it is removed from the list

❍     Add Mode: 
when you click an unlisted element, it is added to the list 
when you click a listed element, it remains in the list

❍     Remove Mode: 
when you click an unlisted element, the list is unchanged 
when you click a listed element, it removed from the list

●     by selecting an element in the list then using the Remove\Replace contextual menu items.

 

If you double-click the Add Mode or Remove Mode button, the chosen mode is permanent, i.e. 
successively selecting elements will add/remove them.  However, if you click only once, only the next 
selected element is added or removed.
You only have to click the button again, or click another one, to deactivate the mode.

4.  Right-click the elements from the 

list and choose the Check 

Selection command.

This let's you check 
whether any element to be 
joined presents any 
intersection (i.e. at least 
one common point) with 
other elements prior to 
creating the joined surface:

The Checker dialog box is 
displayed, containing the 
list of domains (i.e. sets of 
connected cells) belonging 
to the selected elements 
from the Elements To 
Join list.

5.  Click Preview.
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●     An Information message is issued 
when no intersection is found.

   

●     When an element is self-intersecting, 
or when several elements intersect, a 
text is displayed on the geometry, 
where the intersection is detected.

6.  Click Cancel to return to the Join Definition dialog box.

7.  Right-click the elements again and choose the Propagation options to allow the selection of 

elements of same dimension.

 
●     G0 Propagate: the tolerance corresponds to the Merging distance value.

●     G1 Propagate: the tolerance corresponds to the Angular Threshold value, if defined. Otherwise, it 
corresponds to the G1 tolerance value as defined in the part.

Each new element found by propagation of the selected element(s) is highlighted and added to the 
Elements To Join list.
Please note that:

●     The initial element to propagate cannot be a sub-element

●     Forks stop the propagation

●     Intersections are not detected
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8.  Click Preview in the Join Definition 

dialog box.

The joined element is 

previewed, and its 

orientation displayed. Click 

the arrow to invert it if 

needed.

 

The join is oriented according to the first element in the list. If you change this element, the join's 
orientation is automatically set to match the orientation of the new topmost element in the list.

9.  Check the Check tangency button 

to find out whether the elements to 

be joined are tangent. If they are 

not, and the button is checked, an 

error message is issued.

10.  Check the Check connexity 

button to find out whether the 

elements to be joined are connex. 

If they are not, and the button is 

checked, an error message is 

issued indicating the number of 

connex domains in the resulting 

join.

When clicking Preview, the free 

boundaries are highlighted, and 

help you detect where the joined 

element is not connex.
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11.  Check the Check manifold button 

to find out whether the resulting 

join is manifold.

 

The Check manifold button is only 
available with curves.
Checking it automatically checks the 
Check connexity button.

●     The Simplify the result check button allows the system to automatically reduce the number of 
elements (faces or edges) in the resulting join whenever possible.

●     The Ignore erroneous elements check button lets the system ignore surfaces and edges that would 
not allow the join to be created.

12.  You can also set the tolerance at which two elements are considered as being only one using the 

Merging distance.

13.  Check the Angular Threshold button to specify the angle value below which the elements are to 

be joined.

If the angle value on the edge between two elements is greater than the Angle Tolerance value, 

the elements are not joined. This is particularly useful to avoid joining overlapping elements.

14.  Click the Federation tab to generate groups of elements belonging to the join that will be 

detected together with the pointer when selecting one of them. 

 
For further information, see Using the Federation Capability.

15.  Click the Sub-Elements To 

Remove tab to display the list of 

sub-elements in the join.

These sub-elements are 

elements making up the 

elements selected to create 

the join, such as separate 

faces of a surface for 
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example, that are to be 

removed from the join 

currently being created.

You can edit the sub-

elements list as described 

above for the list of 

elements to be joined. 

16.  Check the Create join with sub-elements option to create a second join, made of all the sub-

elements displayed in the list, i.e. those that are not to be joined in the first join.

This option is active only when creating the first join, not when editing it.

17.  Click OK to create the joined surface or curve.

The surface or curve (identified as Join.xxx) is added to the specification tree. 

 

Sometimes elements are so close that it is not easy to see if they present a gap or not, even though they 
are joined. Check the Surfaces' boundaries option from the Tools -> Options menu item, General, 
Display, Visualization tab.

 

Using the Federation Capability

 
This option is only available with the Generative Shape Design 2 product.

The purpose of the federation is to regroup several elements making up the joined surface or curve. This 
is especially useful when modifying linked geometry to avoid re-specifying all the input elements.

 
Open the Join2.CATPart document.

1.  Create the join as usual, selecting all elements to be joined.

(Make sure you do not select the Sketch.1).
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2.  From the Join Definition dialog box 

click the Federation tab, then 

select one of the elements making 

up the elements federation.

You can edit the list of 
elements taking part in the 
federation as described 
above for the list of 
elements to be joined.

3.  Choose a propagation mode, the 

system automatically selects the 

elements making up the 

federation, taking this propagation 

mode into account.

●     No federation: only the elements 
explicitly selected are part of the 
federation
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●     All: all elements belonging to the 
resulting joined curve/surface are part 
of the federation

●     Point continuity: all elements that 
present a point continuity with the 
selected elements and the continuous 
elements are selected; i.e. only those 
that are separated from any selected 
element is not included in the 
federation

●     Tangent continuity: all the elements 
that are tangent to the selected 
element, and the ones tangent to it, 
are part of the federation

Here, only the top faces of 
the joined surface are 
detected, not the lateral 
faces.

 To federate a surface and its boundaries in 
tangency, you need to select the face as 
well as the edges: both face and edges will 
be federated.
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●     No propagation: only the elements 

explicitly selected are part of the 
propagation

4.  Choose the Tangency 

Propagation federation mode as 

shown above.

5.  Move to the Part Design 

workbench, select the Sketch.1, 

and click the Pad  icon to 

create an up to surface pad, 

using the joined surface as the 

limiting surface.

6.  Select the front edge of the pad, 

and create a 2mm fillet using the 

Edge Fillet  icon.

7.  Double-click the Sketch.1 from the specification tree, then double-click the constraint on the 

sketch to change it to 10mm from the Constraint Definition dialog box.
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Sketch prior to modification lying over two 
faces

Sketch after modification lying over one face only

8.  Exit the sketcher .

The up to surface pas is automatically recomputed even though it does not lie over the same faces of the 
surface as before, because these two faces belong to the same federation. This would not be the case if 
the federation including all top faces would not have been created, as shown below.

9.  Double-click the joined surface (Join.1) to edit it, and choose the No propagation federation 

mode.

10.  Click OK in the Join Definition dialog box.

A warning message is issued, informing you that an edge no longer is recognized on the pad.

11.  Click OK.

The Update Diagnosis dialog box is displayed, allowing you to re-enter the specifications for the edge, and 
its fillet.

You then need to edit the edge and re-do the fillet to obtain the previous pad up to the joined surface. 

12.  Select the Edge.1 line, click the Edit button, and re-select the pad's edge in the geometry.

13.  Click OK in the Edit dialog box.

The fillet is recomputed based on the correct edge.
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Splitting Geometry

 

This task shows how to split a surface or wireframe element by means of a cutting element.
You can split: 

●     a wireframe element by a point, another wireframe element or a surface

●     a surface by a wireframe element or another surface.

 
Open the Split1.CATPart document.

1.  Click the Split icon .

The Split Definition dialog box appears. 

 
2.  Select the element to be split.

 

You should make your selection by clicking on the portion that you want to 
keep after the split.

3.  Select the cutting element.

A preview of the split appears. You can change the portion 
to be kept by selecting that portion. 

You can also select the portion to be kept by clicking the 
Other side button. 

You can select several cutting elements. In that case, note that the selection order is important as the area to be split is defined according to the 
side to be kept in relation to current splitting element. 

In the illustrations below, the top-left line is the first splitting element. In the left illustration it defines an area that  intersects with the other 
three  splitting curves, and in the illustration to the right, these three elements are useless to split the area defined by the first splitting element.
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Would you need to remove, or replace, one of these cutting elements, select it from the list and click the Remove or Replace button.

The Elements to remove and Elements to keep options allows to define the portions to be removed or kept when performing the split 
operation. 

●     Click in the field of your choice to be able to select the elements in the 3D geometry.

●     Right-click in the field either to clear the selection or display the list of selected elements.

Only the selected element is removed.
All other elements are kept.

The selected elements are kept.
All other elements are removed.

●     You must select sub-elements as elements to keep or to remove; 
otherwise, a warning message is issued.

 
●     You can also select a point to define the portion to keep or to remove. 

A contextual menu is available on the Elements to remove and 
Elements to keep fields.

 

You do not need to select elements to keep if you already selected elements to remove and vice-versa.
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4.  Click OK to split the element.

The created element (identified as Split.xxx) is added to 
the specification tree. 

●     Check the Keep both sides option to retain the other side of the split element after the operation. In that case it appears as aggregated 
under the first element.

●     Check the Intersection computation button to create an aggregated 
intersection when performing the splitting operation. This element will 
be added to the specification tree as Intersect.x 

 
●     Uncheck the Automatic extrapolation button if do not you want the 

automatic extrapolation of the cutting curve. 
If the Automatic extrapolation button is unchecked, an error 
message is issued when the cutting element needs to be extrapolated, 
and the latter is highlighted in red in the 3D geometry.
To be able to split the surface, check the Automatic extrapolation 
button.

This option is available in the case of a split surface/curve or 
surface/surface.

●     Providing the element to cut is a volume and the cutting element is a volume or a surface, you can choose whether you want the result of the 
split to be a surface or a volume. To do so, switch to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect volumes.
If the result of the split is a volume, the split is a modification feature.
If the result of the split is a surface, the split is a creation feature.
To have further information about volumes, please refer to the corresponding chapter.

●     When splitting a wire (curve, line, sketch and so forth) by another wire, you can select a support to define the area that will be kept after 
splitting the element. It is defined by the vectorial product of the normal to the support and the tangent to the splitting element. 
This is especially recommended when splitting a closed wire. 

The non disconnected elements of the element to cut are kept in the result of the split.

 

Splitting with no support selected: first solution Splitting with no support selected: second solution
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Splitting with a selected support (xy plane): first solution Splitting with a selected support (xy plane): second solution

●     You can create a Join as the splitting element, by right-clicking in the Cutting Elements field and choosing the Create Join item.

If you split a surface and you keep both sides by joining the resulting splits, you cannot access the internal sub-elements of the join: indeed, 
splits result from the same surface and the cutting elements are common.

●     Avoid splitting geometry when the intersection between the element to 
cut and the cutting element is merged with an edge of the element to 
cut.
In that case, you can use the Elements to remove and Elements to 
keep options to remove the positioning ambiguity.

 
●     When splitting a closed surface or a curve by connex elements, an error message is issued. You need to create a join feature of non connex 

elements and cut the closed surface or curve with this join feature. 

  
Splitting surface/curve or surface/surface

The following steps explain how split a surface by a curve or another surface.

 Split surface/curve

1.  First, the cutting element (the curve) is laid down the surface.
2.  Then, the result of step 1 is tangentially extrapolated in order to split the surface correctly (as shown in following figure). However, when 

this extrapolation leads to the intersection of the cutting element with itself prior to fully splitting the initial element, an error message is 
issued as there is an ambiguity about the area to be split.  

If the cutting element does not reach the free edges of the element to cut, an extrapolation in tangency is performed using the part of the cutting 
element that lays down the surface.
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 Split surface/surface

Open the Split2.CATPart document.

1.  First, an intersection (the green wire) is created between the 
two elements (the surfaces).

2.  Then, the result of the intersection is automatically extrapolated 
in tangency up to the closest free edges of the element to cut.
The result of the extrapolation is used as the cutting element 
and the split is created.

Please note that it is not the cutting element which is extrapolated but 
the result of the intersection.

If the result of the split is not what was expected, it is also possible to manually extrapolate the cutting element with the extrapolate feature 
before creating the split.

1.  Extrapolate the cutting element (the red surface) in order to 
fully intersect the element to cut.
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2.  Then, use the extrapolated surface as the cutting element to 
split the surface.

Avoid using input elements which are tangent to each other since this may result in geometric instabilities in the tangency zone.

In case surfaces are tangent or intersect face edges, please process as follow in order to avoid indeterminate positioning. 

Use the border edge of the cutting surface to split the element to cut:

1.  Delimit the boundary of the cutting surface
2.  Project this boundary onto the surface to split
3.  Use this projection as the cutting element

Steps 2 and 3 may be optional if the tangency constraint between the 
two surfaces has been clearly defined by the user during the surface 
creation.

The following cases should be avoided when possible (especially when 
the tangency constraint between the two surfaces has not been clearly 
defined by the user during the surface creation), as the result of the 
positioning is likely to be indeterminate and the result of the 
intersection to be unstable.  
  

  
When these cases cannot be avoided, it is recommended, first to create 
the intersection between the two surfaces, then to split the element to 
cut with the resulting intersection. Doing so, the position can be 
properly defined but the instability of the result relating to the 
intersection remains. 
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 Trimming Geometry 

 
This task shows how to trim two surfaces or two wireframe elements.

 
Open the Trim1.CATPart document.

 
1.  Click the Trim icon .

The Trim Definition dialog box 
appears. 

2.  Select the two surfaces or two wireframe 

elements to be trimmed.

A preview of the trimmed element 
appears. You can change the portion 
to be kept by selecting that portion.

You can also select the portions to 
be kept by clicking the Other side 
of element 1 and Other side of 
element 2 buttons. 
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3.  Click OK to trim the surfaces or wireframe 

elements.

The trimmed element (identified as 
Trim.xxx) is added to the 
specification tree. 

●     You should make your selections by clicking on the portions that you want to keep after the trim.

●     Please refer to the Splitting Geometry chapter in the case surfaces intersect face edges. 

In case the elements to be trimmed are tangent, you are advised to use the Elements to remove and 
Elements to keep options to define the portions to be kept or removed.

●     Click in the field of your choice to be able to select the elements in the 3D geometry.

●     Right-click in the field either to clear the selection or display the list of selected elements.

Only the selected portion is removed.
All other elements are kept.

Only the selected portions is kept.
All other elements are removed.
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●     You can also select a point to define the portion 
to keep or to remove. 

A contextual menu is available on the 
Elements to remove and Elements to keep 
fields.

●     You do not need to select elements to keep if you already selected elements to remove and vice-versa.

  

●     When trimming wires (curve, line, sketch and so forth) by another wire, you can select a support to 
define the area that will be kept after trimming the element. It is defined by the vectorial product of the 
normal to the support and the tangent to the trimming element.

This is especially recommended when trimming a closed wire.

In our example, the Sketch composed of two lines 
(Sketch.11) is trimmed by the circle (Sketch.10).

Resulting trimmed element without support 
selection Resulting trimmed element with support selection

●     Check the Result simplification button to allow the system to automatically reduce the number of 
faces in the resulting trim whenever possible.
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●     Check the Intersection computation button 
to create a completely independent element 
when performing the trimming operation. In 
that case it appears as a separate Intersect.xxx 
element in the specification tree.

 

●     Uncheck the Automatic extrapolation button 
if you do not want the automatic extrapolation 
of the elements to trim. 
If the Automatic extrapolation button is 
unchecked, an error message is issued when 
the elements to trim need to be extrapolated, 
and the latter are highlighted in red in the 3D 
geometry.

 

To be able to trim the two surfaces or wireframe 
elements, check the Automatic extrapolation 
button.
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Extrapolating Surfaces

 
This task shows you how to extrapolate a surface boundary.

 
Open the Extrapolate1.CATPart document.

1.  Click the Extrapolate icon .

The Extrapolate Definition dialog box appears.

2.  Select a surface Boundary.

3.  Select the surface to be Extrapolated.

4.  Specify the Limit of the extrapolation by either:

●     entering the value of the extrapolation length

●     selecting a limit surface or plane

●     using the manipulators in the geometry.

5.  Specify the Continuity type:

●     Tangent

●     Curvature

Tangent Curvature
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6.  Specify Extremities conditions between the extrapolated surface and the support surface. 

●     Tangent: the extrapolation sides are tangent to the edges adjacent to the surface boundary.

●     Normal: the extrapolation sides are normal to the original surface boundary.

Tangent Normal

7.  Specify the Propagation type:

●     Tangency continuity to propagate the extrapolation to the boundary's adjacent edges.

●     Point continuity to propagate the extrapolation around all the boundary's vertices.

 

 Tangent continuity Point continuity

8.  Check the Assemble result option if you want the extrapolated surface to be assembled to the support surface.

This option is now also available with the Curvature continuity.
 

9.  Click OK to create the extrapolated surface.

The surface (identified as Extrapol.xxx) is added to the specification 
tree.
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The Internal Edges option enables to determine a privileged direction for the extrapolation. You can select one or more edges (in the 
following example we selected the edge of Surface.1) that will be extrapolated in tangency. You can also select a vertex once you have 
selected an edge in order to give an orientation to the extrapolation.

You can only select edges in contact with the boundary.

No edges selected One selected edge

The Internal Edge option is only available with the Generative Shape Design product but not with the Wireframe and Surface product.

You can extrapolate several elements at a time. In this case, refer to Editing a List of Elements to find out how to display and manage the 
list of selected elements.

The Up to element Type, the Extremities, and the Internal Edges options are not available with the Curvature continuity type.

 

282Page Quick Surface Reconstruction Version 5 Release 13



Slicing curves
 

This task will show you how to slice curves or edges. 

(The color of the curves have been changed to several shades of blue in the picture below).
The clean contour action sets the chaining order of the curves to create a contour. In some cases (especially with long curves) the chaining may lead to an unexpected result. You may need to slice curves or edges in 
order to solve this chaining incompatibility.

 

original curves: clean contour impossible

 

sliced curves

 

clean contour

The Curves Slice action cuts curves or edges in several pieces, according to a pseudo-intersection: there is a pseudo-intersection between two curves if they intersect each other in the view direction (but not really), and 
if the mini 3D distance between them at this cutting point is lower than the parameter Max. Distance. 
Pseudo-intersection of two curves in the view direction 

 

in another view. 

 

Open the Slice1.CATPart from the samples directory.
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1.  Activate the Geometrical set using the Define in Work Object contextual menu.

2.  Click the Curves Slice icon . The Curves Slice dialog box is displayed.

3.  Select the curves or the edges to slice. The list of the selected curves or edges is displayed in the Selected curves field. You can remove an element from this list by selecting it again. You can then resume the 

selection of the elements.

 

4.  Click Apply. The resulting segments and the cutting point on each curve are pre-visualized. 

The segments smaller than the Min length set are not displayed. 

A message may inform you that the curves or edges do not "pseudo-intersect" each other with respect to the Max distance parameter.

These curves do not intersect each other, whatever the Max distance parameter. There is no solution.
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The curves will intersect each other if you set the Max distance parameter to a value higher than that indicated in the message 
and in the label.

There is no information message, no distance label, only a yellow square: the curves do intersect each other.

5.  Click More >> to display that parameter: Its default value is 1mm. Max distance is the minimum orthogonal distance between two curves above which one considers the two curves do not "pseudo-intersect" 

each other. Increase this value according to your needs (25 mm in our example).

 

 

6.  Very tiny segments may be created. To avoid it, check the Min length box, and set the Min length (i.e. the minimum length of the segments created) value according to your needs.

7.  Click OK to validate the result. The input curves are sent to the NoShow, A new body Slice.x is created in the specification tree, under the current working body, containing the segments created.
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Adjust Nodes

 

It is difficult to re-create surfaces from a network of curves and to make sure that they are perfectly 
continuous. This task shows how to improve a node of the network to this purpose: 

●     the action modifies a set of curves arriving at a same node so that they have the same extremity (G0 
continuity) and the same tangent plane at this node (G1 continuity).

●     this ensures that all surfaces build on each mesh arriving at this node are continuous in tangency.

The curves may be simple curves, 3D curves, face edges... 

Curves are deformed  :

●     to be made G0 continuous (passage continuity) in all cases, 

●     to be made G1 continuous (tangency continuity) according to your needs (for example, you do not 
want to apply a tangency continuity constraint on a sharp edge). 

It is also possible to make two curves tangent to each other. Only the curves constrained to the tangent 
plane are made tangent to each other. The curves set to Continuous only can not be made tangent.

The G0 continuity can be tuned up using the Maximum deviation parameter i.e. the maximum distance 
between the input curve and the deformed curve. 

The G1 continuity can be tuned up using the Max Angle G1 parameter, below which curves are made 
tangent to each other.
Open the AdjustNode01.CATPart from the samples directory.

1.  Define an In Work Object.

2.  Click the Adjust nodes icon . The Adjust Node dialog box is displayed:
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3.  Select the curves to adjust. They are listed in the Selected Curves field. 

You can deselect a curve by picking it, or select another curve.

By default, the curves are "Continuous and tangent"

Click of the label of a curve, or right-click to launch its contextual menu, to change its 
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status. 

 

The available statuses are:

Continuous and tangent: the deformed curves are G0 continuous and tangent to the 

computed tangency plane. 

Continuous: the deformed curves are only G0 continuous. 

Fixed: the curves are not deformed. In particular, face edges are fixed and remain fixed. 

 

4.  Click Apply. The deformations are computed: 

●     The curves selected are highlighted,

●     The curves modified are displayed in green,

●     The tangency plane is displayed in white,

●     Its vector are displayed in pink,

The maximum deviation is also displayed on the most deformed curve, not necessarily on 

that deformation spot. 
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The curves are deformed to reach the required continuity. By default, this deformation is local, meaning 
the curves are deformed at their extremities. You can check the Global deformation option to distribute 
the deformation more evenly on the whole curves. The degree and the structure of the curves are kept.

The result may not be satisfactory. In that case, you can: 

●     Check the Max deviation option and enter the value of the maximum allowed deviation. At the apply, 

the deformation of the curves is computed and displayed. If the deformation is greater than the 

requested tolerance, the value of the maximum deformation is displayed in red, with an error 

message. This is only an information, the node can be created.

●     Check the Max Angle G1 option to force a tangency constraint on the curve end points when the 

angle of the tangents at those ends is lower than the Max Angle G1 value.

 

●     This action processes one node at a time.

●     There must be more than one curve to adjust.

●     Several non continuous fixed curves may lead to inconsistencies.

●     If some curves are deformed too far apart with respect to the tolerance, the adjustment cannot be 
computed and an error message is displayed.
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Splitting CleanContours
 

This task will show you how to split a closed CleanContour by a curve. The output is two open 
CleanContours. 

This may be necessary to create satisfying PowerFit surfaces: when the surface created from a polygon 
and a CleanContour does not respect the accuracy requested, splitting the CleanContour in two and 
creating two surfaces may be the solution.
Open the SplitCleanContour1.CATPart from the samples directory.

1.  Click the CleanContour Split icon . The Split CleanContour dialog box is displayed.

2.  Select a CleanContour to split. The CleanContour must be closed. You can select it either by one 

vertex or by selecting its components one by one.

3.  Go to the Cutting elements field and pick No selection. When it is highlighted in blue, select a or 

several cutting curves. There must be two and only two pseudo-intersections between the cutting 

curve(s) and the CleanContour.

The name of the curves of the CleanContour and of the cutting curve(s) are displayed in 

the dialog box.
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The Split CleanContour action cuts a CleanContour into two CleanContours, according to a pseudo-
intersection: there is a pseudo-intersection between two curves if they intersect each other in the view 
direction, and if the mini 3D distance between them at this cutting point is lower than the parameter Max. 
Distance.

4.  Click Apply.  The split is displayed.

5.  Click OK. The two open CleanContours (joins) are created, the curve it trimmed accordingly. A 

split.x element is created in the specification tree. It contains the two joins created.
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●     You may want to select a join. If this join contains a sliced surface edge, or a split CleanContour that 
contains a sliced surface edge, with a tangency constraint that you want to keep, pick the curves one 
by one, graphically, i.e. do not select a join by picking one vertex, nor select the elements in the 
specification tree.

 

Possible problems

If the input CleanContour is not closed, the gap is displayed and no computation is started.

A closed CleanContour as a cutting element may cause an ambiguity. A message asks you which part of 
the cutting CleanContour you want to use. 
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The Max distance parameter may be too low. Set a higher value and try again.

For example, the curve seems correct in the view direction, but the 3D distance is higher than the set Max 
distance (in our example, 1mm).

 

The cutting curve is not suitable. Modify it and try again.
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You may enter several curves as cutting elements, but they must be connex: 
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It is not possible to split a CleanContour made of one element like this one
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Creating Edge Fillets
Edge fillets are useful to provide a transitional surface along a sharp internal edge of a surface.

This task shows how to create a constant radius fillet along the internal edge of a joined surface.
The fillet surface is obtained by rolling a sphere over the selected edge.

Open the EdgeFillet1.CATPart document.

1.  Click the Edge Fillet icon .

2.  Select the edge to be filleted.

You can also select a face, provided there is no ambiguity as to the edge(s) to be filleted. 

 
The Edge Fillet Definition dialog box appears. 

3.  Use the combo to select the desired type of extremity for the fillet:

●     Straight: no tangency constraint is imposed at the connecting point between the fillet and the initial 
support, generating sometimes a sharp angle.

297Page Quick Surface Reconstruction Version 5 Release 13



 

●     Smooth: a tangency constraint is imposed  at the connection between the fillet surface and the 
support surfaces, thus smoothing the connection

●     Maximum: the fillet surface is limited by the longest selected edge

●     Minimum: the fillet surface is limited by the shortest selected edge

4.  Enter the value of the fillet Radius.

A preview of the fillet appears.

5.  You can choose the Propagation type:

●     Tangency: the fillet is propagated up to the first edge that is not continuous in tangency.

●     Minimal: the fillet is propagated up to the first geometric limitation.

 

Use the More >> button to access further options: Edge(s) to keep and Limiting element and Blend 
corner.
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6.  Click OK to create the fillet surface.

The surface (identified as EdgeFillet.xxx) is added to the specification tree. 

 

 

●     Check the Trim support elements option to relimit the support elements and assemble them to the 
fillet.

Keeping Edges 

You may also need to explicitly indicate edges that should not be filleted, if a radius is too large for 
example. In this case you cannot select boundary edges to be kept, but only internal edges, i.e. edges 
limiting two faces.

Open the EdgeFillet2.CATPart document.
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To do this, proceed as above, but once you have selected the edge to be filleted, click the More to expand 
the dialog box, then click the Edge(s) to keep field and select the edge you wish to keep.

 

If you have difficulties selecting the edge, use the up/down arrows to display the preselection navigator.

This edge is displayed in pink, meaning that it will not be affected by the fillet operation. 

Then, click OK to create the fillet surface.

Limiting Fillets
While creating the fillet, you can limit it by selecting an element (plane or surface) that intersects it 
completely:
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1.  Once the edge to be filleted has been selected, and the radius keyed in, click Preview then the 

More button.

2.  Click in the Limiting element field, then select the trimming element. These elements can be 

either surfaces, planes or points on edges.

An arrow indicates which portion of the fillet is to be retained.

  

●     It is now possible to use one or more limiting elements.

●     You can define a limiting element just by clicking a point on one of the selected edges to be filleted.

3.  Click on this arrow to inverse it, if needed, to retain the opposite side of the fillet.
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4.  Click OK to create the limited fillet.

In the illustration, the limiting surface has been hidden.

 You can create limiting elements just by clicking on the edge to be filleted.

The application displays this element as a blue disk.

Make sure that the limiting element is not larger than the initial element, as illustrated here. In this case, 
decrease the size of the limiting element as prompted by the warning message.
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Trimming Overlapping Fillets
In some cases, fillets may be overlapping. The Trim ribbons option lets you solve this by trimming the 
fillets where they overlapping.

Open the EdgeFillet3.CATPart document.

1.  Click the Edge Fillet icon  and, using the Ctrl key, select the edges at the base of the cylinder 

and the one along the vertical surface.
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2.  Click Preview.

The two fillets clearly overlap.

3.  In the Edge Fillet Definition dialog box, check the Trim ribbons option and click OK.

Note that the Trim ribbons option is available with the Tangency propagation mode: 
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●     In Minimal mode, the Trim ribbons option is grayed, as it is implicitly active. The results would be 
trimmed fillets, and no propagation:

●     In Tangency mode, with the Trim ribbons option unchecked, the fillets intersect, with no trimming, 
and the propagation is performed
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●     In Tangency mode, with the Trim ribbons option checked, the fillets are trimmed and the 
propagation is performed.

 

Reshaping corners:

Sometimes, while filleting, you can see that corners resulting from the operation are not satisfactory. The 
new capability "Blend Corners" lets you quickly reshape these corners. 

 

Open the BlendCorner1.CATPart document.

1.  Click the Edge Fillet icon  and fillet the edges as shown using 5mm as the radius value. 
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2.  Taking a closer look at the corner, you can notice that the edges need to be rounded again. 

3.  After launching the Edge Fillet dialog box to edit the fillet, click the More>> button to access 

additional options.

 
4.  Click the Blend corner(s) button to detect the corner to reshape. In our example, only one 

corner is detected. The application shows it in the geometry area (3D text).

 

When the application detects several corners, it is not possible to reshape just a few of them: all of them 
will be edited.

The setback distance field determines for each edge a free area measured from the vertex along the edge. 
In this area, the system adds material so as to improve the corner shape.

5.  Enter a value in the setback distance field. For example 13.

307Page Quick Surface Reconstruction Version 5 Release 13



6.  Click Preview to examine the result.

To edit the distance for the top edge, click "13" and enter "22" as the new value in the 
Setback distance field. 

7.  Repeat the operation for the edge below using the same distance value

8.  Click OK to confirm the operation. The corner is reshaped.
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Workbench Description
This chapter describes the menus, sub-menus, items and toolbars of the Quick Surface Reconstruction. 

Menu Bar
Creation Toolbars
Analysis Toolbars
Specification Tree 

310Page Quick Surface Reconstruction Version 5 Release 13



Menu Toolbar
This chapter describes the menus available in Quick Surface Reconstruction. Other menus are documented in 
the Infrastructure User's Guide.

Start SmarTeam File Edit View Insert Tools Windows Help

 
Start     

 Starts Quick Surface 
Reconstruction Workbench

 
Insert     

 
 Geometrical set  

Managing Geometrical 
Sets

 Cloud Edition  Cloud Edition

 Scan Creation  Scan Creation

 Curve Creation  Curve Creation

 Domain Creation  Domain Creation

 Surface Creation  Surface Creation

 Operations  Operations

 Transformations  Transformations

 Segmentation  Segmentation
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 Analysis  Analysis

 WireFrame  WireFrame

 
Cloud Edition     

  Activation  
Activating a Portion of a 
Cloud of Points

 
Scan Creation     

 

Curve Projection Projecting Curves

 Planar Sections  
Cutting a Cloud of Points 
or a Polygon by Planar 
Sections

Free Edges Creating Free Edges

 
Curve Creation     

 

 3D Curve  

Creating Associative 3D 
Curves and Creating 
Associative 3D Curves on 
Scans

Curve from Scans Curves from Scans

Intersection Creating Intersections

Projection Creating Projections
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Domain Creation     

 
 Clean Contour  Clean Contour Creation

 Curves Network  Curves Network

 
Surface Creation     

 
 Basic Surface Recognition  Basic Surface Recognition

 Power Fit  PowerFit

 Loft  Creating Lofted Surfaces

Surfaces Network Surfaces Network

 
Operations     

  Join  Joining Surfaces or Curves

 Extrapolate  Extrapolating Surfaces

 Split  Splitting Geometry

 Trim  Trimming Geometry

 Curves Slice  Slicing curves

 Adjust Nodes  Adjust Nodes

 Split CleanContour  Splitting CleanContour

Edge Fillet  Creating Edge Fillets

 
Transformations     

 

 Translate  Translating Geometry

 Rotate  Rotating Geometry

Scale
Transforming Geometry by 
Scaling

 Symmetry  
Performing a Symmetry on 
Geometry

Affinity
Transforming Geometry by 
Affinity
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 Axis To Axis  
Transforming Elements 
from an Axis to Another

 
Segmentation     

 
 Segmentation by Curvature  

Segmentation by 
Curvature Criterion

Segmentation by Slope
Segmentation by Slope 
Criterion

 
Analysis     

 

Information Information

 Distance Analysis  
Analyzing Distances 
Between Two Sets of 
Elements

Curvature Analysis
Performing a Curvature 
Analysis

 Connect Checker  
Checking Connections 
Between Surfaces

 
WireFrame     

 
 Point  Creating Points

 Line  Creating Lines

 Plane  Creating Planes

 Circle  Creating Circle

 
Tools     
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  Cloud Display Options  
Display Options and 
Graphic Properties
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Creation Toolbars
This chapter describes the menus available in Quick Surface Reconstruction. Other menus are documented in 
the Infrastructure User's Guide.

Cloud Edition
Scan Creation
Curve Creation

Domain Creation
Surface Creation

Operations
Transformations
Segmentation

Analysis
WireFrame
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Cloud Edition
 For  See

 Activate Activating a Portion of a Cloud of Points
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Scan Creation
 For  See

 Project Curves  Projecting Curves

 Planar Sections  Cutting a Cloud of Points or a Polygon by Planar Sections

 Free Edges  Creating Free Edges
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Curve Creation
  For  See

  3D Curve  
Creating Associative 3D Curves and Creating Associative 3D Curves on a Scan of 
Cloud

  Curves from Scans Curves from Scans

  Intersection  Creating Intersections

  Projection  Creating Projections
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Domain Creation
  For  See

  Clean Contour  Clean Contour Creation

  Curves Network  Curves Network
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Surface Creation
  For  See

  Basic Surface Recognition Basic Surface Recognition

  PowerFit  PowerFit

  Loft Surface  Creating Lofted Surfaces

  Surfaces Network  Surfaces Network
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Cloud and Curve Operations
For See

Join Joining Surfaces or Curves

Extrapolate Extrapolating Surfaces

Split Splitting Geometry

Trim Trimming Geometry

Curves Slice Slicing Curves

 Adjust nodes Adjust Nodes  

Split CleanContour Splitting CleanContours

Edge Fillet Creating Edge Fillets
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Transformations
For: See:

Translate Translating Geometry

Rotate Rotating Geometry

Symmetry Performing a Symmetry on Geometry

Scale Transforming Geometry by Scaling

Affinity Transforming Geometry by Affinity

Axis to Axis Transforming Elements from an Axis to Another
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Cloud Segmentation
 For  See

 Segmentation by Curvature Criterion Segmentation by Curvature Criterion

 Segmentation by Slope Criterion  Segmentation by Slope Criterion
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Cloud Analysis
 For  See

 Information  Information

 Distance Analysis  Analyzing Distances between two Sets of Elements

 Curvature Analysis  Performing a Curvature Analysis

 
 Connect Checker  Checking Connections between Surfaces
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WireFrame
 

   For  See

  Point  Creating Points

  Line  Creating Lines

  Plane Creating Planes

  Circle Creating Circle
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Tools Toolbar
This chapter deals with:

 Cloud Display Options Display Options and Graphic Properties
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Specification Tree
Within the Quick Surface Reconstruction workbench, you can generate a number of elements that are identified in the 
specification tree by the following icons. If you open a CATPart generated with other CATIA applications, other icons 
may appear in the specification tree. 

Please note that the pictures below are only example. The names and contents of elements will vary according to 
your actions.

Further information on general symbols in the specification tree are available in Symbols Used in the Specification 
Tree.

Icon Action Icon Action

Geometrical 
Sets

 

Group

Project 
Curves 

Planar 
sections

Create Free 
Edges

3D Curve

  
Curve from 
Scans

Intersection Projection

Clean 
Contour   
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Basic Surface 
Recognition

Basic Surface 
Recognition

Basic Surface 
Recognition

Basic Surface 
Recognition

Powerfit, 
Surfaces 
Network

Curves 
Network

Loft Surface   

Symmetry Axis to Axis

Scale Rotate

Translate Affinity
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Segmentation 
by Curvature 
or Slope 
Criterion

Segmentation 
by Curvature 
or Slope 
Criterion

Join Adjust Nodes

Split Trim

Extrapolate Edge Fillet

Curves Slice
Split 
CleanContour

Distance 
Analysis

Curvature 
Analysis

Connect 
Checker   
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Glossary 

   

B
boundary A boundary of trimmed or natural surfaces is defined by a clean contour.

C
clean contour A clean contour is a set of curves or surface edges, joined, ordered, eventually trimmed, with 

G0, G1 or G2 continuity constraints.

curves They may be created through: 
●     sketches on polygons,

●     smoothing of scans,

●     blending of curves,

●     canonic recognition (line, circle),

●     accuracy checking.

S
scans They can be obtained by : 

●     the identification of feature points (boundaries, sharp edges, breaks in curvature, inflection 
lines),

●     sketches on polygons.

segmentation This operation defines zones on the cloud of points through: 
●     curvature criteria,

●     normal criteria (isoslope, outlines),

●     feature recognition (sphere, cylinder, plane, cone),

●     threshold of distance deviation from a given surface,

●     It may include scans or curves.

●     It may be automatic, manual or both.

 

331Page Quick Surface Reconstruction Version 5 Release 13



Index 

                     

Numerics
3D Curve 

Command    

A
Activate 

command  
Adding split points 

Curve from Scans  
Adjust nodes 

command  
Advanced 

PowerFit  

Surfaces Network  
Affinity 

command  
All Point Continuity 

Surfaces Network  
All Tangent Continuity 

Surfaces Network  

analysis   

analyzing    
Angle 

Segmentation by Slope Criterion  
associative curve 

creating  
Automatic tangency 

Curves Network  
Automatic Tangent Constraint 

CleanContour  
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AutoSort Open Body 

command  
Axis To Axis 

command  

B
Basic Surface Recognition   

command  
bisecting 

lines  
bi-tangent and point 

circles  
bi-tangent and radius 

circles  

C
Change Body 

command  

checking connections  
Chordal Error 

Project Curves  
Circle 

command  

circles        

CleanContour      

command  
CleanContour Split 

command  
Closed Contour 

CleanContour  
closed sections 

multi-section surface surfaces  
Cloud 
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Surfaces Network  

Cloud Display      

command  
Cloud Display Options 

Cloud Display  

color scale  

Command    

command                   

                    

        
Compass 

Segmentation by Slope Criterion  
Compute with ribbons 

Surfaces Network  
Connect Checker 

command  

PowerFit  
constant radius 

fillets  
Constrain on element 

Curve from Scans  
Constraint on curves 

CleanContour  
Constraints 

Curves Network  

PowerFit  

Surfaces Network  
Continuity 

PowerFit  
corner 

reshaping  
Counterdraft 

PowerFit  

coupling  

multi-sections surfaces  
Create Curves 
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Planar Sections  

Project Curves  
Create Free Edges 

command  

creating          

circles  

circular arcs  
curvature 

analyzing  
Curvature analysis 

Curve from Scans  

Curve from Scans            

command  
curves 

joining  

Curves Network            

command  

Curves network   
Curves Slice 

command  

D
datum 

creating  
Default constraints 

Curves Network  
Delete wire 

Curves Network  
Deleting wire 

Curves Network  
De-Select all 

Surfaces Network  
Deviation 

PowerFit  

335Page Quick Surface Reconstruction Version 5 Release 13



Surfaces Network  
Display constraints 

Surfaces Network  
Display selection 

Surfaces Network  
distance 

analysis  
Distance Analysis 

command  
distance between elements 

analyzing  

E
Edge Fillet 

command  
edges 

filleting  
Editing the list of elements 

CleanContour  

elements  

symmetric  

translating   
elements by affinity 

creating  
elements by intersection 

creating  
elements by projections 

creating  
elements by rotation 

creating  
elements by scaling 

creating  
elements by symmetry 

creating  
Extrapolate 
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command  

extrapolating  

F
filleting  

fillets   
Filter 

Segmentation by Curvature Criterion  

Free Edges  
Freeze 

Curves Network  

G
Gap 

PowerFit  

Surfaces Network  
geometrical sets 

inserting  

managing  

removing  

reordering  
Graphic properties 

Cloud Display  
Guide 

Planar Sections  

H
history  
How it works 

CleanContour  
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I
Influence area 

Planar Sections  
Information 

command  

PowerFit  
Init Surface 

Surfaces Network  
Input 

Basic Surface Recognition  
Input elements 

PowerFit  
Insert Geometrical Set 

command  

inserting  

Interoperability   
Interpolation 

Curve from Scans  

intersecting  
Intersection 

command  

J
Join 

command  

joining   

L
Limiting curve 
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Planar Sections  
line 

command  

creating  

lines  

M
managing  

manual coupling  

multi-sections surfaces  
Max distance 

Curves Network  

Slicing Curves  
Max. Order 

Curve from Scans  
Max. Segments 

Curve from Scans  
Maximum deviation 

Curve from Scans  
Maximum order 

Curve from Scans  
Messages 

Slicing Curves  
Min length 

Curves Network  

Slicing Curves  

moving  
multi-output 

selecting  

multi-section surface surfaces  
Multi-Sections Surface 

command  

multi-sections surfaces    
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creating  

N
Node tolerance 

Curves Network  

non-updated  
Not selected 

Surfaces Network  

O
open bodies 

moving  

sorting  
Order 

PowerFit  

Surfaces Network  
Output 

Basic Surface Recognition  

Segmentation by Curvature Criterion  

Segmentation by Slope Criterion  
Overlapping curves 

Curves Network  

P
Parameters 

PowerFit  

Surfaces Network  

Planar Sections       

command  
plane 
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command  

creating  
point 

command  

creating  
point center and radius 

circles  
Point Continuity 

Surfaces Network  
Polyline and Point 

Cloud Display  
porcupine curvature 

analysis  
Porcupine Curvature Analysis 

command  

PowerFit                  

command  

Project Curves      

command  

projecting  
Projection 

command  
Projection Direction 

Project Curves  
Projection on support 

Curves network  
Properties 

command  

R
Radius 

PowerFit  

Surfaces Network  
relimiting 
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multi-sections surfaces  
Remove Geometrical Set 

command  
Remove Surface 

Surfaces Network  

removing  
Reorder Body 

command  

reordering  
Reset parameters 

Surfaces Network  

reshaping  
Results/Display 

Surfaces Network  
Rotate 

command  

rotating  

S
Sampling 

Cloud Display  
Scaling 

command  

scaling  
Scan type 

Planar Sections  
Segmentation 

PowerFit  

Surfaces Network  

Segmentation by Curvature Criterion    

command  

Segmentation by Slope Criterion    

command  
Segments 
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PowerFit  

Surfaces Network  
Select all 

Surfaces Network  
Selected 

Surfaces Network  

selecting  
Show Historical Graph 

command  
Show Information 

PowerFit  

Slicing Curves    
Smoothing 

Curve from Scans  
Smoothing tolerance 

Curves network  

sorting  
Spikes 

PowerFit  

Surfaces Network  
Split 

command  
Split angle 

Curve from Scans  
splitting 

elements  

Splitting CleanContours  
Standard 

Surfaces Network  
Support 

Curves Network  
surface connection 

analyzing  
surfaces 

checking connections  

extrapolating  
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joining  

Surfaces Network                  

             

command  
Swap Selection 

Surfaces Network  
Symmetric 

command  

symmetric  

T
Tangent Continuity 

Surfaces Network  
Tension 

PowerFit  

Surfaces Network  
three points 

circles  
Tolerance 

Curve from Scans  

Surfaces Network  
Translate 

command  

translating   
Triangles 

Cloud Display  
Trim 

command  
trimming 

elements  
tri-tangent 

circles  
two points 

circles  
two points and radius 
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circles  
Type of Projection 

Project Curves  
Types 

Segmentation by Curvature Criterion  

U
Update 

command  

updating  

W
Working Distance 

Project Curves  
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